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Project Management

Enterprise Architect has been built from the ground up with the Project Manager in mind. Organizational repositories are
valuable corporate assets and must be managed and maintained accordingly. Risk can be modeled and managed in a
variety of locations, and project effort can be determined with built in support for Metrics and Estimation. Tasks can be
created and assigned to Resources performing particular roles, and these can be conveniently viewed in a built-in Gantt
Chart. There is an Audit function that allows changes to be tracked at a fine grained level, and a Team Review facility
and Element Discussion that allow users to work collaboratively on models.

Each element in Enterprise Architect has a number of default properties that are useful for project management, such as
phase, version, status, author and creation and modified dates. Using these, coupled with the powerful reporting engine,
the information can be extracted easily even by a novice user. The Project Manager and other users have the ability to
create elegant charts that depict the information in the repository in a compelling visual format. For example, a pie chart
could be created to show the status of stakeholder requirements for a particular phase of the project.

Facilities

Facility Detail

Metrics and Estimation Project estimation is working out how much time and effort is required to build and
deploy a solution.

Enterprise Architect provides the Use Case metrics facility as a means of:
e  Measuring the complexity of a system
e  Getting an indication of the effort required to implement the model

e  Getting an indication of the project timescale

You base these estimates on carefully-calibrated metrics.

Resource Management Resources are the people who work on a project.

You can assign roles to resources and allocate tasks on specific model elements,
which enables tracking of effort and estimation of time to complete.

Project Maintenance During a project you monitor and manage the development and progress of
individual model elements.

You can record problems, changes, issues and tasks that affect these individual
elements as they arise, and document the solution and associated details.

Similarly, Enterprise Architect helps you to manage changes and issues that apply
to the whole system.

Project Tasks and Issues In the course of a project, there are various non-technical tasks that are vital to the
successful management and completion of the project, such as meetings.

Enterprise Architect helps you to record and monitor these, and to manage
non-technical project issues as they arise.
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Kanban Features

Background

Kanban, which literally translates as Visual (Kan) Card (Ban) or billboard, is an operational method used to increase
efficiency. It was originally developed by the industrial engineer Taiichi Ohno while working at Toyota. Ohno analyzed
the way supermarket shelves are stocked and applied the lessons learnt to the factory floor, creating unprecedented
efficiency. The visual card (Kanban) was used to signal the need for more items to upstream suppliers on the production
line. The Kanban method can be applied to any field, including strategic planning, sales and marketing, and human skills
management, but more recently Kanban has been applied to the process of developing software-centric solutions in an
attempt to ensure that value is delivered to the customer as quickly as possible. The information technology industry has
been plagued since its beginning with projects running over schedule and over budget, but more significantly failing to
deliver value to customers in a time frame that enables them to compete and be successful. These endemic issues have
become a critical element of business in an age dominated by digital disruption and unprecedented change.

Principles

Kanban is fundamentally very simple and relies on a small number of principles, the origins of which can be attributed to
the engineers at Toyota:

e Make work visible
Traditional project management methods hide the work items from the people who carry out the work; Kanban
exposes the work to everyone, allowing any team member to contribute to the way work items flow through the
board and ultimately deliver value to the customer

Backlog Queue In Progress (4/6) Test/Review

-

r L

As an Administrator | want to
be able to have a
maintenance window to

update online web pages and
content

UserStory

e  Limit work in progress

As a Customer | want to be
able to add new orders to
existing ones if they have not
shipped

Defect

Paulene Dean

E 1 Busin..
. J

As a Sale Representative |
want to be able to view
historical leads

UserStory

Jane Ward
=] Devel.

As a Warehouse Manager |
want to be able to determine
the best product location to
minimize picking errors

UserStory

Yuki Kotabashi
S ] TestA..
\ J

Project managers and team leads have traditionally been under pressure to get products finished or to include more
features, and have responded to this pressure by burdening the team with more work items; this results in lots of
focus switching and inevitably half-finished items and reduced efficiency
Paradoxically, Kanban encourages the number of items in progress to be limited, resulting in greater efficiency and

more finished items; the reduced number of in-progress items allows team members to concentrate on one thing at a

time without having to switch focus
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Mame Max [tems Colar Default Unbound
Backlog 0 |:| Default v
Queue 20 |:| Default
{In Progress | |:| Default
Test/Review 3 |:| Default
Done 20 |:| Default
Deploy 50 |:| Default

e Manage the flow of work
Using traditional project management methods, bottlenecks or blockers are hard to identify and typically only
surface at the time of a post project review, often only after the product is delivered late and missing features
Using Kanban, the visibility of work and the ability to identify stalled processes - whether because of bottlenecks or
lack of work items - allows a flow problem to be identified and rectified quickly
The next diagram shows the way the Kanban facility in Enterprise Architect responds when the number of items in a
lane exceeds the number specified in the max items (Work in Progress or WIP limit) value for that lane; the header
is highlighted in a configurable color and the numbers (number of items/max items) also provide a visual queue that
will prompt the team to respond by swarming (a number of team members focusing) on the lane to reduce the
number of items

Queue

gt
As a Customer | want to be
able to add new orders to
existing ones if they have not
shipped

Defect

Paulene Dean
= Busin...

&

As a Customer | want to be
able to view the status of my
order

In Progress (7/6)

i
As a Sale Representative |
want to be ahle to view
historical leads

UserStory

Jlane Ward
— Devel...

iy
As a Reviewer | want to be
able to be able to add and edit
rules in the online grammar
checker

Test/Review

A
As a Warehouse Manager |
want to be able to determine
the best product location to
minimize picking errors

UserStory

Yuki Kotabashi
TestA...

i
As a Customer | want to be
able to rent an item for a
specified duration

UserStory UserStory UserStory
Pat Taylor Paulene Dean
e — G+ Pr... [— TestA...
Flexibility

Enterprise Architect has a flexible and integrated Kanban facility built into the core product, allowing projects of any
size and vertical market to benefit from the profound efficiencies that come with this simple, elegant and lean project
management approach. Regardless of the type of process that is being used, Enterprise Architect’s Kanban features can
be quickly and seamlessly integrated into any method, creating a compelling visual solution and team collaboration
platform that will result in products, services and solutions being delivered to customers with efficiency and in record
time - delighting both product owners and customers alike.

The Kanban features in Enterprise Architect are highly configurable and can be altered to suit any team and process,
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including Agile, iterative and incremental, and even waterfall projects. There is a very low barrier to adoption and teams
can commence with Kanban immediately. The most basic Kanban board comprises a diagram divided into a small
number of lanes; a range of work items can be added to the diagram, including Features, User Stories, Defects, Changes,
Use Cases, Requirements and more. Work Items can be drawn with a compelling visual style representing a colored card,
and can be dragged anywhere in the diagram to change order in a given lane, or from lane to lane progressing from left to
right through the board, representing progress towards value for the customer. The lanes are typically bound to the values
of a 'project management aware' property such as status or phase, and as the item is dragged from lane to lane the value
of the bound property is automatically changed.

Resource Allocation

Any number of resources, performing specified roles, can be allocated to work items as they flow through the Kanban
board, and the progress can be visualized as one or more progress bars displayed at the bottom of the card. The allocation
is driven by Enterprise Architect's practical and simple resource allocation facility, which can be used to define the
relationship between resources (team members) and work items (cards). Any number of team members can assign
themselves to a work item, indicating the role they will perform, and the start date, finish date, and the expected time can
be used to record estimates of how long the task will take.

In Progress (5/6)

. @
As a Sales Representative |
want to be able to view

historical leads

Userstory

Jane Ward

[= ] Devel...

Pat Taylor

— ] C++ Pr...
LN 4

Progress can be updated as a percentage of completion, which can be displayed visually on the card. The Kanban board
(like any diagram) can also be displayed as a Gantt chart or a list view, supporting alternative project management
representations.

Resource Allocation

HHEXN & BEN @

Resource Role Resource: Jane Ward - || Start Date: 05-D6-2016 ~  Expected Time: 6
Jane Ward Developer || Role or Task: | Developer - | End Date:  13-06-2016 *  Allocated Time: 8
Pat Taylor C++ Programmer |° Complete %: 15 : Time Expended: 2

Description | History

Configuration

The Kanban cards can be configured to display an extensive set of properties, with compelling icons, colors and progress
bars to communicate the important aspects of the work item, resource allocation and work item progress. The properties
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include the item name, type, status, version, priority, stereotype, phase, author and more.

In Progress (2/8)

r il
As a Stock Control Manager | want to be
able to list stock levels for a selection of

titles.

Userstory
Version: 1.0

Paulene Dean
1 Business A

L "

The names, colors and number of lanes can be configured, in addition to a range of other properties such as the overfill
limits, defaults and the definition of sub-lanes. The appearance of the board and the work items can all be configured,
using different colors, fonts and styles including a hand-drawn mode that might appeal to teams more accustomed to
using a physical board with colored notes. It is also possible to set the chart appearance to highlight elements that come
from the same hierarchies.

Enterprise Architect has built-in Kanban diagrams, and a number of workflow Patterns that are pre-built and that can be
used 'As-Is' or configured to suit any project or initiative. The workflow Patterns define one, two or three stage
workflows; for example, the two stage workflow defines a Kanban board solely for managing the prioritization of the
backlog, and items from the backlog are then moved from the backlog Kanban to the first lane of the iteration Kanban. If
necessary, the Product Owner can use Enterprise Architect's security facility to lock the backlog Kanban, ensuring that
the order of items in the backlog is not inadvertently changed.

There are a number of commercial tools that allow Kanban to be used to manage projects visually, but Enterprise
Architect’s Kanban facility is incredibly powerful because the tool is also a sophisticated modeling platform for strategic
and business analysis, architecture, design, implementation, testing and deployment. This means that work items on a
Kanban Board can be linked to strategic decisions, business rules, policies, requirements, architecture and design
elements, wireframes and UX models, programming code, database tables, procedures, tests, virtual or physical
deployment nodes, and more. For the first time everyone in the team can collaborate in the same environment using a
toolbox of facilities purpose built for their discipline, while at the same time being able to visualize and manage the value
being delivered to the customer in a powerful and visually compelling set of Kanban boards.

Example

A high priority User Story that is at the top of the backlog could be pulled into the 'In Progress' lane and a developer
could immediately commence work on it. The work might entail the coding of business rules, the review of detailed
requirements, changes to a database schema or the addition of an element or attribute to an information schema, and the
creation of a new or updated deployment environment.
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In Progress (5/6)

As A Student | want to buy
books at Academic Prices

Userstory

Pat Taylor
— C#++ Pr...
L o

All of these artifacts can be found inside the same repository without the need to launch other tools or schedule meetings
to locate the needed information. The strategic drivers can be seen in the context of their business owners, architectural
design and principles can be viewed, Business Rules can be visualized in relation to the policies they qualify, a live
connection can be made to the databases and their schemas analyzed and altered, XML schemas can be inspected and

messages constructed, programming code can be written and deployment targets detailed, and all of this achieved in a
single collaborative platform.
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Rules Analyzer

notes «trace»
This is a customer built rules engine
used to manage configuration items.|
It has been extended to allow rules to
be viewed and updated through a
business web interface.
T
|
|
«trace»
\'A
As A Student | want to I]j
buy books at Academic L1 [~~~ =
) «trace»
Prices
Requirement «UserStory»
Version: 1.0 Phase: In Progress
Priority: High
M
| AN
| N
. N
«trace» AN
' Ay
|
|
Student Verification E
«column»

ID: NUMBER(8,2)

INSTITUTION NAME: NVARCHAR(50)
YEAR: NUMBER(4,2)

STUDENT NUMBER: VARCHAR2(20)

Charts and Dashboards

()

«goal»
Provide customers with a
competitive online shopping
experience

(from Goals)

«business rule» {
Any person studying who is under
the age of 27 with student
identification is considered a
student

(from Bufﬁess Rules)
|
|
|

«trace»
1

«enforces»

REQ117 - The system must provide
amechanism allowing students to
identify themselves

«trace»

(from Take Orders)

(&)

This Requirements diagram
shows a User Story that has
been added to a Kanban
diagram expressing the
relationships to a number of
business and technical
elements.

30 June, 2017

ce»

«policy»
The bookstore will provide
discounts to students to
encourage learning

(from Policies)

N\

° [e]

il 2:55 PM

Name

Institution

A United States
Stanford

Harvard

Student Number

o

Enterprise Architect has a sophisticated charting facility that can be used to create powerful and expressive charts and
dashboards that will provide insights into the Kanban process and enable Product Owners and other team members to
monitor performance and determine ways of fine tuning how the team is working. There are a range of built-in charts

including bar and pie charts, heat maps and more but a team is free to create any number of user-defined charts and these

can be incorporated into team processes and reviews.
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Completed Tasks Last Week

Ali Evans
Alma Cogan
Billy Bunter

Bob Brown

Brett Chambers

Carlos Wallace

Carmen McRae

o
David Kelly
1

e H Test
Donna Campbell | B Rework
Eric Burns - B Review
Ethan Rogers ' H Proposal
Frank Mclver 1 ' [ Investigate

B Implement

Josh Morgan 30§ |

Liam Cross
Nigel Molesworth
1]

Pat Taylor 1 --
Penny Dark 1

Peter Ryan
Philip Marlowe -

Application

The Kanban project management methodology helps you to develop a dynamic, easy-to-view progress summary of the
stages of development of a project, where the stages are represented as lanes and sub lanes of a diagram - a Kanban
Board. In Enterprise Architect, you can apply a form of this methodology to your project administration diagrams to
monitor and manage the flow of work in a particular area.

The stages of development can be defined by the value of a project management property of an element, such as Phase,
Version or Status, or a user-defined Tagged Value. The elements that represent each task or object of a task are initially
placed in the lanes for the earlier stages of the project, and work on the task is reflected by moving the corresponding
element to a different lane on the diagram. If a diagram is linked to a project management property, dragging an element
from one lane to another automatically changes the value of the property to the value that the lane represents.

In this illustration, the lanes identify what work is being performed in each stage of development.
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Queue

In Progress (4/6)

Test/Review

AsaCustomer | want to be able|

AsaCustomer | want to be able]

my order

UserStory
Validated
High

AsaReviewer | want to be able|
to be able to add words to the
online dictionary

Userstory
Proposed
Medium

Prices for some publishers do
notinclude internal storage
costs

Defect
Proposed
Low

to
onesifthey have not shipped

Stock levels on financial
reportsdon't include returned|
items.

AsaWarehouse Manager |
want to be able to determine
the best product location to
minimize picking errors

Userstory Defect
Proposed Approved Userstory
Medium Low Proposed
Low
Theresa Moranti
= ] Java pr. Yuki Kotabashi
Iwantto ] TestA

be it
pagesand content want to be able to view AsaCustomer | want to be ablel

historical leads torentanitem for a specified
Userstory e
Validated Userstory ur
High Validated UserStory

Medium Proposed

Medium

‘Adam Goodchild
AsaReviewer | want to be able| Solutio, Paulene Dean
to be able to add and edit rules| Pat Taylor TestA...
inthe online grammar checker| @6 _—————
UserStory panolWarc
Proposed Develo. AsaStock Manager | want to
Medium be able to predict product

AsaCustomer | want to be ablel
to delete itemsfrom my order
before it is shipped

Userstory

Approved
High

‘The Online Shop web site

country drop down list is
missing anumber of small
countries

Defect
Proposed
Medium

Benjamin Hutton
G Pr..

AsA Student | want to buy

booksat Academic Prices
Userstory

Proposed

High

Pat Taylor

| —

demand

Userstory
Proposed

Medium

30 June, 2017

Done Deploy

Priority
O wign
(3 Medium
(3 tow

New tasks will usually begin in the left-most lane, and completed tasks will usually pass through all lanes before coming
to rest in the right-most lane and then being moved off the diagram. A typical workflow is to choose the next task that
you are going to work on by starting in the right-most lane and seeing if it has any tasks that you are able to progress; if
not, move to the next lane and repeat, and so on.
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MDG Technology for Kanban

The MDG Technology for Kanban Diagrams provides diagram types and patterns that underpin the creation of Kanban
diagrams. Whilst it is possible to create Kanban diagrams from most UML diagram types and design the workflows on
them from scratch, these diagram types and patterns help you to generate a Kanban that matches your requirements and
then adjust the settings to suit, thus saving time and effort.

Access
On the 'MDG Technologies' dialog, select 'Kanban', then click on the 'Enabled' checkbox and on the OK button.

Ribbon Configure > Technology > Manage > Technology

Kanban Diagram Types

The MDG Technology for Kanban Diagrams provides four kinds of pre-defined Kanban diagram, as described here. To
create one of these diagrams, open the 'New Diagram' dialog, select 'Kanban' in the left-hand pane and choose one of the
diagram types from the right-hand pane.

Diagram Type Description
Basic The Basic Kanban diagram contains these lanes:
e Backlog
e  Queue

e In Progress
e Done

The Basic Kanban diagram doesn't have a lane binding to any element property.

Backlog The Backlog Kanban diagram contains these lanes:
e Low
e Medium
e High
e (ritical

The lanes are bound to the element Priority, so that moving elements between lanes
will automatically update their Priority to the name of the lane.

Iteration The Iteration Kanban diagram contains these lanes:
e  Queue
e In Progress
e Test/Review
e Done

The lanes are bound to the element Phase, so that moving elements between lanes
will automatically update their Phase to the name of the lane.

Complete The Complete Kanban diagram contains these lanes:

e Ready for Release
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e Staging
e  Production
e Done

The lanes are bound to the element Phase, so that moving elements between lanes
will automatically update their Phase to the name of the lane.

Kanban Workflow Patterns

Kanban Workflow model Patterns help you to very quickly set up a one, two or three stage workflow, using and linking
the Backlog, Iteration and Complete Kanban diagrams.

Workflow Pattern Description

1-stage Workflow Pattern The 1-stage Workflow Pattern consists of a single Kanban diagram with the
Backlog, Queue, In Progress, Test/Review, Done, and Deploy lanes. These lanes
are linked to the Phase property of elements, so that moving elements between
lanes will automatically update their Phase to the name of the lane.

2-stage Workflow Pattern The 2-stage Workflow Pattern consists of two related Kanban diagrams:

e A Backlog Kanban diagram with Low, Medium, High and Critical lanes linked
to the Priority property of elements, so that moving elements between lanes
will automatically update the Priority to the name of the lane, and

e  An Iteration Kanban diagram with Queue, In Progress, Test/Review, Done and
Deploy lanes linked to the Phase property of elements, so that moving elements
between lanes will automatically update their Phase to the name of the lane

Each diagram also has a drop zone that helps you to move elements easily between

diagrams. Simply drag the elements onto the appropriate zone (having the name of

the diagram to move elements to) and select either 'Move to' to move the element to
the new diagram, or 'Create link on diagram' to create a link on the second diagram

without removing it from the current diagram.

3-stage Workflow Pattern The 3-stage Workflow Pattern consists of three related Kanban diagrams:

e A Backlog Kanban diagram with Low, Medium, High and Critical lanes linked
to the Priority property of elements, so that moving elements between lanes
will automatically update the Priority to the name of the lane

e  An Iteration Kanban diagram with Queue, In Progress, Test/Review, and Done
lanes linked to the Phase property of elements, so that moving elements
between lanes will automatically update their Phase to the name of the lane,
and

e A Complete Kanban diagram with Ready for Release, Staging and Production
lanes linked to the Phase property of elements, so that moving elements
between lanes will automatically update their Phase to the name of the lane

Each diagram also has a drop zone that helps you to move elements easily between

diagrams. Simply drag the elements onto the appropriate zone (having the name of

the diagram to move elements to) and select either 'Move to' to move the element to
the new diagram, or 'Create link on diagram' to create a link on the second diagram

without removing it from the current diagram.
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Kanban Tasks

Create a Kanban Diagram

30 June, 2017

A Kanban diagram is a board that allows team members to visualize work items that are represented as colored cards.
The board is divided into a number of lanes and team members move the cards from left to right as work is completed
towards providing value to the customer.

You can create a Kanban diagram by taking an existing diagram and setting its Kanban properties, but it is easier to use
one of the diagram types provided by the MDG Technology for Kanban Diagrams as a starting point and then change its
properties to suit your own project.

Step Action

1 In the Project Browser, right-click on the parent Package and select the 'Add Diagram' command.

2 In the 'New Diagram' dialog, select 'Kanban' in the 'Select From' list, and choose from the four diagram
types (Basic, Backlog, Iteration and Complete). Give the new diagram a name in the 'Diagram' field and

click on the OK button.

Mew Diagram x

Type

Select From:

Package : | Project Core

Diagram : | Project Core

i Entity Relationship Diagram
Eriksson-F‘enker Extensions
’EFF_AF Diagrams

[=fGmL

(S} GRA-UML

&

F

Diagram Types:

'E'g Basic
'E'g Backlog
'E'g Iteration

'E'g Complete

IE Kanban

(=} MIEM

[SjmMIEM 3.0

[=joDm

= LieberLieber Autosar Engineer
[=]Mind Mapping

[EF] Owner [Zachman Framewaork]
[EE]Flanner (Zachman Framewaork)

Kanban

QK Cancel Help

3 If you can't find 'Kanban' in the list, you must enable the Kanban MDG Technology.

Add Elements to a Kanban Diagram

Work items are represented visually on a Kanban diagram but first must be added to the diagram. They can be elements
that already exist in the repository or new elements dragged from the Kanban toolbox and dropped onto the diagram.

(c) Sparx Systems 2015 - 2017
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Any element type can appear on a Kanban board but the most typical types are Features, User Stories, Defects and
Changes, Use Cases, Scenarios and Requirements are also sometimes added.

When you drop an element onto a Kanban diagram, the lane it is added to depends on whether the diagram has a property
value defined, and also whether it has a default lane. If the Kanban diagram has a property value defined and the new
element's property matches one of the lanes, then it will be added to that lane. Otherwise, it will be moved into the
default lane, or to the right of the last lane if no default lane has been nominated.

You can define the Default lane on the 'Lanes' page of the 'Kanban Options' dialog.

The Kanban Toolbox page will open automatically whenever you open a diagram created from the MDG Technology for
Kanban Diagrams. The Toolbox page provides a default set of elements that you can use to represent units of work on
your Kanban diagrams, but any type of element can be added.

Step Action

1 Open your Kanban diagram. The Diagram Toolbox should appear with the Kanban page selected
automatically.

e [fthe Diagram Toolbox doesn't appear, click on the >> button in the top left corner of your diagram

e [fthe Kanban page isn't automatically selected, click on the More tools button in the Toolbox and
select 'Kanban' from the list

2 Drag elements from the Kanban page onto the Kanban diagram. The page provides these element types:
Toolbox O x
Mare toaols...
Elements
ﬁ Change
Defect
L Feature

User Story

Commaon
Artifacts

Import a Kanban Workflow Pattern

Each organization or team will typically want to define their own workflow that is appropriate for the initiatives they
work on and each might have a number of workflows defined for different types of initiatives. While this can be done
from scratch it is much easier to use one of the built-in Patterns, either 'As-Is' or as a starting point. A workflow can be
made up of any number of Kanban boards linked together into a single workflow, for example a three stage workflow
would contain three separate boards. Each board can be configured with any number of lanes and sub-lanes representing
the stages in that part of the workflow. Team members can move Work Items between lanes in a single board and also
between the boards that make up the entire workflow.

Kanban Workflow model Patterns help you to very quickly set up a one-, two- or three-stage workflow, using and
linking the Backlog, Iteration and Complete Kanban diagrams.

Step Action

1 In the Project Browser, select the Package under which to create the Workflow Pattern.
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Click on the Project Browser header and select the 'New Model from Pattern' option, or press
Ctrl+Shift+M. The Model Wizard window displays.

B Model Wizard

Model Patterns | Application Patterns VEA Examples
Add to Package Business Process Model ] Customize Pattem on import
Technology MName P
Core Modeling - Kanban
BRMHN IE 1 stage workflow
SysML . IE 2 stage workflow
Business (8] [«] 3 stage workflow
Database
Software : MindMapping
Services |E| Mind Mapping Diagram
Geospatial
EI : Strategic Modeling
Others |E| Balanced Scorecard
|E| Strategy Map
|E| Value Chain
=] Flow Chart
|E| Decision Tree
|E| Organization Chart
: UMM 2.0 Profile
IE ERV Model Structure [Downloaded)
@ BCW Model Structure [Downloaded)
|E| BT Adndal Stroctura iMmssenlnadadl -
A Kanban wordlow including Backlog, teration and Complete diagrams.
All Mone
Cancel Help

Select the 'Model Patterns' page and, under 'Technology' in the left pane, select 'Business'. In the right
pane, in the 'Kanban' group, click on the checkbox against one or more of the Patterns and then click on
the OK button. The Patterns you can choose from are:

e | stage workflow
e 2 stage workflow

e 3 stage workflow

If you have the 'Customize Pattern on import' checkbox selected, prompts display to select the Packages to
import in the Patterns. Each Pattern contains one Package, which is automatically selected. Click on the
OK button for each Pattern.

Open each of the new diagrams and consider whether they fit with your own workflow preferences. The
diagrams provided can be changed to suit your style of working.
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Moving Kanban Items

Work Items flow through Kanban boards typically from left to right as work is performed moving the item closer to
delivering business value for the customer. In a one stage workflow work items will be move through a series of lanes
through a single board but in workflows that are comprised of more than one Kanban board the items will also jump from
one board to the next. For example in a two stage workflow there ia a backlog board and items will be prioritized in the
board based on their priority. The work items which have the highest priority in the Backlog then need to be moved to
the Iteration Board where implementers will pull them into the In-Progress lanes.

Moving Items in a Kanban Diagram

Moving items within a Kanban diagram is simple and intuitive and can be achieved by dragging and dropping a work
item from one location to another. If an item is moved within the same lane its position is simply changed in that lane. If
an item is dragged to a different lane and the lanes are bound to an element property or user defined Tagged Value the
value of the item's property or tag will also be changed.

Step Action

1 Select the item in the Kanban diagram
2 Drag and drop it into a new position either in the same lane or a different lane
Notes

When an item is moved between lanes and the lanes are bound to a property or Tagged Value the value of the property or
Tag will be automatically changed.

Example
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Backlog Queue
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Userstory

Userstory
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items 2

Defect

Moving Items between Kanban Diagrams

Items can be moved between Kanban boards by using a drop zone positioned to the right of the diagram. The drop zones
have the name of the other diagrams in the workflow and elements on the current board can simply be moved by
dragging and dropping them on the drop zone.

To move the work item to another Kanban board simply drag it onto the appropriate zone (with the same name as the
diagram you are moving elements to) and select 'Move to' to move the element to the new diagram or 'Create link on
diagram' to create a link on the second diagram without removing it from the current diagram.

Step Action

1 Select the item in the Kanban diagram

2 Drag the item to the right of the Kanban diagram Lanes

3 Drop the item on the appropriately named drop zone element.

4 Select 'Move to' to move the element to the new diagram or 'Create link on diagram' to create a link on the

second diagram without removing it from the current diagram

Example

In this diagram a work item representing a defect is being moved from the critical lane of a Backlog Kanban board to the
Iteration board.
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Search for Kanban Diagrams

A well organized repository will assist in quickly locating specific Kanban diagrams, but in large and complex initiatives
it is common for some team members to need to search for Kanban Boards. Enterprise Architect has an easy-to-use yet
sophisticated search facility with a built-in search to find all Kanban diagrams in the repository. Having located a
diagram the user can continue moving objects from left to right across the board, contributing to the team's effort focused
on providing value to the customer.

Step Action

1 Select the 'Construct > Task Management > Kanban > Find Kanban Diagram' ribbon option.

The search is immediately executed and the located diagrams are listed in the Find in Project view.

2 Double-click on any Kanban diagram that you want to open.

Layout Filter Panel

A project of any appreciable size will typically have a large number of in-flight work items, and product owners and
team members will often want to filter the selection of items based on a set of conditions, such as high priority
requirements or those applying to particular stakeholders or people. This can be achieved using filters at two levels;
either the expedient ribbon Filter or the more sophisticated and persistent Diagram Filters facility.

Kanban diagrams with a large number of elements can be quickly filtered in real time using the Layout ribbon Filter
panel.

1. Access the Filter panel.
2. Select the Filter property and the operator (if appropriate), and specify a search term.

Mame / Alias - T

Filter
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Elements not matching the specified condition will be obscured in the filtered diagram.

Backlog Queue In Progress (3/6) Test/Review

As a Customer | want to be
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able to delete items fram my
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As a Customer | want to be
able to rent an item for a
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As a Customer | want to be
able to view the status of my
order

UserStory

UserStory UserStory

Paulene Dean
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Kanban Diagram Options

Enterprise Architect provides a number of options for generating a new Kanban diagram or for opening an existing
Kanban diagram. Having opened the diagram, you can define its structure, content and appearance. It is also possible to
configure a diagram of any other type to be a Kanban diagram, by simply adding Kanban properties to it. This powerful
design feature means that a diagram containing, for example, a set of User Stories could simply be changed to a Kanban
diagram and the team could immediately begin using this flexible, lean, project management method.

To define the structure, content and appearance of a Kanban diagram, you use the 'Kanban' dialog.

E Kanban

+ Configuration Pt
Filters ropeies
e Enabled Show Names in Title Bar Swimlane width locked
Sub-lanes
Appearance Select how you would like to fill this Kanban diagram {eave blank to manually add elements) Run Search
Remove Add
Source Dretails Include Child Packages
4 4 » ¥ - Package ; Custom 5QL
Cancel Help
Access
Ribbon Construct > Task Management > Kanban > (options to generate and/or open a
Kanban diagram) or
Start > Today > My Kanban (displays personal default Kanban diagram)
Then
Design > Diagram > Manage > Kanban (on an open Kanban diagram)
Context Menu On a Kanban diagram, double-click on a lane
On any other type of diagram, right-click on background | Kanban
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Kanban Options - Configuration

When you display the 'Kanban' dialog, it defaults to the 'Configuration' page. You use this page to set up some basic
Kanban properties, such as whether Kanban is enabled on the diagram, if the names are shown in the title bar of the
diagram and if the width of each swimlane is locked.

Additionally, on this page you can set up the automatic filling of a Kanban diagram based on Packages or SQL searches.

To fill a diagram based on a Package, simply click on the Add button and on the 'Add Package' option, select the
required Package from the 'Select a Package' browser, and then click on the Run Search button. This will automatically
add any missing elements based on the search. The search is additive and will only add elements not currently on the
diagram; it will not remove elements that no longer match the search. The Package search can be filtered using a search
created on the 'Filters' page (see the Kanban Options - Filters section).

Alternatively, you can write a custom SQL search to fill the diagram, by clicking on the 'Custom SQL' tab and adding the
appropriate SQL. In order for the diagram to be filled, you must include in the SQL Select statement:

Object ID as Element ID

It is not possible to use both a Package search and a custom SQL search at the same time.

Option Action

Enabled Select the checkbox to apply any of the Kanban functionality to the diagram. If the
checkbox is not selected, the diagram will behave as a non-Kanban diagram.

Show Names in Title Bar Select this checkbox to display the lane names (but not the sub-lane names) in the
diagram title bar, above the lanes. These will be visible once the lanes are defined.

Swimlane width locked Select this checkbox to prevent the lanes in the diagram from being made narrower
or wider.
Run Search If you want to fill a Kanban diagram automatically, you can set up either a Package

search or a custom SQL search. When the search is set up, you click on the Run
Search button to fill the diagram.

Add On the 'Package' tab, if you are using a search or filter (from the 'Filters' page of the
dialog) you must define a Package or Packages for the search or filter to work on.
You do this by clicking the Add button and choosing either 'Add Package' to
browse to a selected Package, or 'Search Model' to search or filter from all elements
in the current model.

Remove If you want to clear a Package from the list (or the whole-model selection) click on
the item line and click on this button.

Include Child Packages If you have selected a Package with a child structure, select this checkbox to also
include the elements from the structure in the Kanban diagram, or clear the
checkbox to include elements from the selected Package only.

Notes

e The elements in a Kanban diagram individually represent work in progress; you cannot create connectors between
elements on the diagram

e Ifyou apply a Kanban definition to a current diagram, all connectors on the diagram are hidden; when you
de-activate the definition, the connectors are shown again
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e When you first set up a Kanban diagram, any element on the diagram that does not have one of the defined property
values is moved to the right-hand side of the diagram
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Kanban Diagram Options - Filters

The 'Filters' page can be used in conjunction with the Package search defined on the 'Configuration' page, should you
want to apply additional filtering.

E Kanban
Configuration Mamow the Kanban results to elements matching these conditions.
i Filters
5 Element Filter
- Lanes
Sub-lanes Import Search w Add Filter Edit Fitter Remove Filter
.. Appearance
Search In Condtion Look: For Required

There are no tems to show in this view.

Element Features
Optional Required

Cancel Help

It is possible to import a model search that has already been created, or to create new filters here exactly as you would
for any other model search.

When adding any of these searches or filters, you must also select at least one Package for the search or filter to work in;
you do this on the 'Configuration' page of this 'Kanban' dialog.

Access

Ribbon Construct > Task Management > Kanban > (options to generate and/or open a
Kanban diagram) or

Start > Today > My Kanban (displays personal default Kanban diagram)
Then
Design > Diagram > Manage > Kanban > Filters (on an open Kanban diagram)

Context Menu On a Kanban diagram, double-click on a lane > Filters
On any other type of diagram, right-click on background | Kanban > Filters
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Filter Options

Option Action

Import Search Click on this button to import a search from either an external XML file ('From
File") or from the current model ('From EA").

Add Filter Click on this button to define the properties of elements that you want to be added
automatically to your Kanban diagram.

e Note that not all element types will be added to Kanban diagrams; the list of
excluded types includes Constraint, Note, Port, ProvidedInterface,
RequiredInterface, Boundary, Hyperlink, StateNode, Text, GUIElement,
Package, UMLDiagram, InterruptibleActivityRegion and ExpansionRegion

Edit Filter Click on this button to edit the currently selected filter in the list.

Optional / Required Choose 'Optional' if the filters will be applied with a logical OR relationship.
Choose 'Required' if the filters will be applied with a logical AND relationship.

Remove Filter Click on this button to delete the currently selected filter from the list.
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Kanban Diagram Options - Lanes

The Lanes' page helps you to create, modify and delete the primary lanes on a Kanban diagram. You can create the lanes
manually, or you can define a property that the lanes bind to, so that the lanes are generated automatically from that
property when you click on the Fill from binding button. You can also add lanes that are not bound to the property. For
each lane you can define the maximum number of elements that can be placed in the lane before triggering the
'Overfilled' indicator, and the fill color of the lane. You can also define the default lane that new elements are added to.

E' Kanban
- Configuration _
il Ise this page to bind a Kanban to a property or tagged value (moving elements into a lane will
ol ters change the property) and to create the main lanes for the diagram.
----- Lanes
----- Sub-lanes
----- Appearance
Bind Kanban to:  Hement.Status Fill from binding
Mame Max Items Color Default Unbound
To Do 0 [ ] deeant
In Progress i] l:' deedfl
Review 5 D deedfl
Done ] D deedfl
New Modiy Delete d
OK Cancel Apphy Help
Access
Ribbon Construct > Task Management > Kanban > (options to generate and/or open a
Kanban diagram) or
Start > Today > My Kanban (displays personal default Kanban diagram)
Then
Design > Diagram > Manage > Kanban > Lanes (on an open Kanban diagram)
Context Menu On a Kanban diagram, double-click on a lane > Lanes
On any other type of diagram, right-click on background | Kanban > Lanes
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Lane Options

Option Action

Bind Kanban t .
na harban o Click on the l_l button and select the property to bind lanes to. This will be one

of:

e Element, or

e Tagged Value (enumeration or string types only), or
e None (makes all lanes unbound).

If you select 'Element', also select one of the properties 'Phase’, 'Version', 'Priority’
(for Requirement-type elements), 'Status' or 'Author’.

If you select 'Tagged Value', also choose to either 'Create' a new tag (and simply
type in the name) or 'Select’ an existing one.

In the latter case, the 'Kanban tagged value selection' dialog displays, on which you
click on the appropriate radio button to select either from a list of 'Global Tagged
Values', or from a list of 'Tagged Values from a selected element'. Click on the
Select Element button to browse for the element anywhere in the model.

The Global Tagged Values or those from the element are provided to the 'Tagged
Value' field. Click on the drop-down arrow on the right of the field and select the
reference Tagged Value from those listed. Click on the OK button.

The 'Bind Kanban to' field now displays either the element property or the Tagged
Value you have selected.

Fill from binding If you have chosen an element property to bind the Kanban lanes to, click on the
Fill from binding button to fill the lane list with existing values of that property.
This will delete all old lanes before creating a new lane for each of the new values.
Once the lanes have been created in this way, they can be renamed, reordered and

added to.

Name The name of each lane can be filled automatically using the Fill from binding
button. You can overtype the names; these do not have to be unique but they cannot
be blank.

Max Items You can set the maximum number of elements that can be placed in each lane. If

someone tries to move an element into a lane that has reached or exceeded its
maximum number, the heading of the lane will be displayed in the 'Overfilled' color
you define and enable on the 'Appearance’ page. This gives an visual indication that
action might have to be taken to clear what appears to be a bottleneck in the
workflow process.

Color Several or all of the lanes can have the same fill color, or you can set a different
color for each lane independent of the other lanes. Either:

e [Leave the 'Color' value set to 'Default' (set on the 'Preferences' dialog,
'Gradients and Background' page), or

e  Opvertype 'Default' with the hex code number for the required color, or
e  Click on the drop-down arrow and select a color from the displayed palette

The actual color is shown in the box at the left of the field.

Default You can nominate one of your lanes as the default; that is, the lane to which new
elements are added if they don't match the binding property. For example, if a
Kanban diagram is bound to 'Priority’ and has the lanes "Low', 'Medium' and 'High',
with 'Low' as the default, when an element with a Priority of 'Undetermined' is
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added, it will be placed into the default 'Low' lane. You can only select one 'Default’
checkbox; clicking on a checkbox clears any previously-selected checkbox.

Unbound The Unbound property essentially makes a primary lane the same as a sub-lane.
Moving an element into an unbound lane will set the element's bound property to
the left most bound lane. Consider a 'Phase’ Kanban diagram with these lanes, in
order:

e To Do (Default, Unbound)
e [mplement (Bound)

e To Do (Unbound)

e Review (Bound)

e To Do (Unbound)

e Deploy (Bound)

Newly added elements will be added to the left-most "To Do' lane with whatever
priority value they previously had. Moving them to the 'Implement' lane will then
set the phase to 'Implement'. When the implementation is complete, the element can
be moved to the '"To Do' lane before 'Review' without updating the element's phase
until it is moved into the 'Review' lane.

New Click on this button to define a new lane on the Kanban diagram.
Delete Click on a line in the 'Lanes' list and click on this button to delete the lane.
uphand Click on an entry in the 'Lanes' list and click on this button to move the entry one
@ line up in the list, and one lane to the left on the diagram.
downhand Click on an entry in the 'Lanes' list and click on this button to move the entry one
@ line down in the list, and one lane to the right on the diagram.

Notes

e Moving an element into a lane automatically sets the appropriate property of that element to the value represented by
the lane; for a Tagged Value, if the element does not have that tag, adding the element to the lane adds the tag and
sets it to the lane value

e Elements on a Kanban diagram are automatically adjusted to match the width of the lane they are in, both when the
element is moved into a lane and when the lane width is changed
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Kanban Diagram Options - Sub-Lanes

E Kanban

- Configuration
: |Ise this page to create sub4anes forthe diagram.

Filters
Lanes Subdanes can be added to the parent lanes once created by checking the appropriate checkhox.
Sub-lanes
... Appearance
Check all Uncheck all

MName To Do In Progress Review Done

Bruce i

Selina i

New Modfy Delete LI

Cancel Apphy Help

Sub-lanes are a useful device for defining another level in the workflow; for example, you might want to divide the
'In-Progress' lane into a number of sub-lanes representing the individual developers, or any lane into 'In-Progress' and
'Complete'. The 'Sub-lanes' page helps you to quickly and easily create any number of new sub-lanes for a Kanban
diagram.

You add sub-lanes simply by clicking on the New button and, in the 'Name' column, typing the sub-lane name.
Alternatively, you can leave the default string '<anonymous>' to create an un-named sub-lane, which can be useful for
organizing lanes that have lots of elements.

Once you have created sub-lanes, they must be applied to one or more parent lanes by selecting the checkbox under the
column heading for each parent lane that is to contain the sub-lane. To assign every sub-lane to every lane, you can click
on the Check all button, and to clear this total assignment click on the Uncheck all button. You can also change the order
of the sub-lanes across all their parent lanes in the Kanban diagram, by clicking on the sub-lane names and on the
up-hand and down-hand buttons.

Within a specific parent lane column you can apply custom sorting to the sub-lanes, so that the sub-lanes in that lane are
in a different sequence to the same sub-lanes in a different lane. For a column that has assigned sub-lanes (contains
selected checkboxes) right-click on the header and select the 'Set lane order' option. A small dialog displays, in which
you click on the sub-lane names and use the up-hand and down-hand buttons to put them in the required sequence. Click
on the OK button to clear the dialog and apply the sub-lane. If a sub-lane order has been customized, you can return it to
the 'across-the-board' order by right-clicking the header again and selecting the 'Reset lane order' option.

Access
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Ribbon Construct > Task Management > Kanban > (options to generate and/or open a
Kanban diagram) or

Start > Today > My Kanban (displays personal default Kanban diagram)
Then

Design > Diagram > Manage > Kanban > Sub-lanes (on an open Kanban diagram)

Context Menu On a Kanban diagram, double-click on a lane > Sub-lanes

On any other type of diagram, right-click on background | Kanban > Sub-lanes

Notes

e  Sub-lanes are not backwards compatible with earlier releases of Enterprise Architect; if you open a Kanban diagram
containing sub-lanes in a release of the system earlier than Release 12.1, the sub-lanes will be permanently deleted
from the diagram

e Elements on a Kanban diagram are automatically adjusted to match the width of the sub-lane they are in, both when
the element is moved into a sub-lane and when the sub-lane width is changed
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Kanban Diagram Options - Appearance

Using the 'Appearance’ page, you can set the Kanban diagram appearance options such as the line and font colors and use
of the Hand Drawn mode.

E Kanban

- Configuration

Filters

Lanes

Sub-lanes Line Color: O Defautt - Hide Names

... Appearance

PP Fait Gk [r—— Bold Fort

Title Color: | Tl T
Owverfilled Color: O Defaut -~ +| Enable Overfill Highlight

Underfill Color: | (1 Defaut  ~ Enable Underfill Highlight

Line Width: 1 -

Vertical Spacing:  Medium -

| lUze Kanban drawing style

Type Stereotype
Status Phase

Wersion Authaor
Priority Truncate name
Bold name hd Icon

Cancel Apphy Help

Objects on a Kanban diagram are, by default, drawn using the Info View style.

- 1T
Location 1 NPC design

Task

Version: 1.0

This style displays an icon on the top right corner of the element, representing the element type, with a triangular icon to
the left of it representing the priority - red for High priority, and yellow for Medium priority. No icon shows for Low
priority. The Priority, as for various other element properties, is also represented by a line of text in the body of the
element. You can specify which properties are shown by selecting the appropriate checkbox from the list at the bottom of
the 'Appearance’ page.

Appearance Options
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Option Action

Font Color Click on the drop-down arrow and select the color in which to display the text in
the Kanban lane and sub lane headings.

If the color you require is not shown, click on the Other button and either select
from a wider range of standard colors or define a custom color.

Line Color Click on the drop-down arrow and select the color in which to display lane borders.
This color does not apply to sub lane borders, which are automatically set to a pale
or dark color to contrast with the lane fill color.

If the color you require is not shown, click on the Other button and either select
from a wider range of standard colors or define a custom color.

The border style is automatically set to the 'chiseled' effect to give the appearance
of 3D blocks on a background, the color of the background being the line color. The
effect is more obvious if you set the line to a pale color and not black.

A Click on this button to display the 'Font' dialog, through which you define the font
and the style, size and effects of the text in the Kanban lane and sub lane headings.

If you also change the text color here, it overrides the setting of the 'Font Color'
field.

Title Color Click on the drop-down arrow and select the color to use across the lane heading
cells (separate from the fill colors you can apply individually to each of the lanes
themselves).

If the color you require is not shown, click on the Other button and either select
from a wider range of standard colors or define a custom color.

Overfilled Color Click on the drop-down arrow and select the color with which to fill a lane heading
cell if the lane contains more than the maximum number of elements. You set the
maximum number of elements when you define the lanes to work with, in the
'Lanes' page.

If the color you require is not shown, click on the Other button and either select
from a wider range of standard colors or define a custom color.

Underfill Color Click on the drop-down arrow and select the color with which to fill a lane heading
cell if the column contains fewer than the maximum number of elements, in other
words there is available capacity. You set the maximum number of elements when
you define the lanes to work with, in the 'Lanes' page.

If the color you require is not shown, click on the Other button and either select
from a wider range of standard colors or define a custom color.

Line Width Click on the drop-down arrow and select the line width of the Kanban lane borders
- either 1 (thinnest), 2 or 3 (thickest).

Vertical Spacing Set this to 'Small’, Medium' or 'Large' to define the degree of vertical separation
between elements in a Kanban lane.

Hide Names Select this checkbox to hide the lane names and the column heading cells.

Bold Font Select this checkbox to display the lane headings in bold (if their font definition
does not already set them to bold).
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Hand Drawn Select this checkbox to display the Kanban lanes and the elements on the diagram
in 'Hand-drawn' mode.

Enable Overfill Highlight Select this checkbox to apply the 'overfilled' color to the lane header cell if it
contains more elements than the defined maximum number (see New).

Enable Underfill Highlight Select this checkbox to apply the 'underfilled' color to the lane header cell if the
lane contains fewer elements than the defined maximum number; that is, if it has
any spare capacity.

Use Kanban drawing style Select this option if you want to apply the Kanban style to the elements on this
Kanban diagram. Also, select the checkbox against each element property or
characteristic to be shown in the elements:

e Type - displays the element type

e  Status - displays the element status

e Version - displays the element version

e  Priority - displays the element priority

¢ Bold name - boldens the element name

e Stereotype - displays the element stereotype

e Phase - displays the element phase

e  Author - displays the name of the element's author

e  Truncate name - cuts off the element name as it approaches the element border,
instead of allowing it to wrap around

e [con - selected by default; deselecting this checkbox hides the Type and
Priority icons in the top right corner of the element

The property checkboxes are directly linked to the 'Use Kanban drawing style'
option. If you do not select the option, the element on the Kanban diagram has a
more basic appearance with no properties shown other than the Author and element
names.

Alfred
Location 1 NPC design

Notes

e  All elements added to a Kanban diagram initially have the same height and spacing, but the height can change as
displayable information is added to an element

e In a Kanban diagram, the normal element appearance option is not operational; only the Kanban appearance options
take effect
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Default Kanban Diagrams

Using Default Kanban Diagrams

A default Kanban diagram can be set for the entire repository, and each individual user can also set their own default
Kanban diagram; in both cases there are specific options to locate and open the diagrams. These defaults help you to
quickly and easily get access to a Kanban board and immediately start contributing to work items that will deliver value
to the customer.

To track your own work, you can select:

e  The 'Start > Today > My Kanban' ribbon option, or

e  The 'Construct > Task Management > Kanban > Open My Kanban Diagram' ribbon option
To track the team's work, you can select:

e  The 'Construct > Task Management > Kanban > Open Project Kanban Diagram' option or

e  The 'Model Default Kanban' menu option from the diagram Caption Bar

* *| Toolbox v 1
@ Show 5tart Page

User Default Diagram
User Default Kanban
Model Default Diagram
Model Default Kanban

'Eg Backlog
'Eg Specification Manager

Set the Model Default Kanban

A default model Kanban diagram can help you to visually track a range of work items and their current stage of
development through an initiative. This feature ensures that all team members can visualize the important work items in
a consistent way and allows them to track the work items as they move from an idea in the backlog through to
completion ultimately delivering business value to the customer.

Step Action

1 Ensure the preferred Kanban diagram is open in the main view.

2 Right-click on the diagram background and select the 'Set as Model Default Kanban' context menu option.

Set My Default Kanban

In a shared security-enabled model environment it is possible to set a user-specific default Kanban diagram. A
personalized Kanban diagram can help each member of a team to visually keep track of a range of elements of particular
relevance to them, and their current stage of development.
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Step Action

1 Ensure your preferred Kanban diagram is open in the main view.
2 Right-click on the diagram background and select the 'Set as My Default Kanban' context menu option.
Notes

e  The model must have user security enabled in order to define a user default Kanban diagram
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Allocating Resources to Work Items

Enterprise Architect not only helps you to define the work items for a Kanban diagram or workflow but also acts as a
sophisticated platform for the allocation and management of resources and the flow of items through the board. This
functionality uses both Kanban diagrams and the Resource Allocation features.

Resources are the people who work on a project; they can be assigned roles and allocated tasks, and these roles and tasks
can be visualized on a Kanban diagram.

In Progress (5/6) Test/Review

As a Sales Representative | As a Warehouse Manager |
want to be able to view want to be able to determine
historical leads the best product location to
minimize picking errors
UserStory
Validated UserStory
Medium Proposed
Low
Adam Goodchild
[(—— | Soluti... Yuki Kotabashi
lane Ward Llil Test 4. )
[ ] Devel...
Pat Taylor - L]
e | C++Pr.. As aCustomer lwant to be ab g
- S to rent an item for a specified

This example shows a number of Kanban work items, one with three resources allocated to it. The tasks performed by
the resources are at varying stages of completion, represented by the green progress bars that show the percentage of the
work completed.

When a resource allocation is set to 100% complete, it will no longer be displayed in the Kanban object. When all tasks
have been set to 100%, it might be time to move the task to the next Kanban lane, changing its status so that the next
resources can be allocated. In this example, that might be resources with a 'Review' or 'Testing' role.

Resource Allocation

To allocate a resource to a Kanban object, you must first open the Resource Allocation window (‘Construct > Task
Management > Resource Allocation'). You then select the object on the Kanban diagram or in the Project Browser and
click on the New' icon in the Resource Allocation window. Add these details as necessary:

e Resource

e Role or Task

e  Start Date

e End Date

e Complete %

e  Expected Time

o Allocated Time
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e Time Expended
e Description
e History

Click on the Save icon to create the resource allocation - a progress indicator will instantly appear on the work item in
the Kanban diagram. This is an important visual cue to show that a resource has been assigned to work on this task or has
chosen it themselves. Other team members will immediately be able to see the allocation on the Kanban diagram and
make decisions about what work items they will work on. Therefore, it is important not to allocate resources too early as
this could slow down the workflow.

The resource allocations for the Kanban Work Item in the previous diagram are shown in this example:

Resource Allocation O =
.-"_'\_- 4 4 l|',||: =

ti d B X B & BEH @

Resource Role Allocated Time Expended Time % Completed Start End

Jane Ward Developer 14 2 15 15-Jun-16 20-Jun-16
Pat Taylor C++ Programmer 7 3 50 16-Jun-16 22-Jun-16
Adam Goodchild Solution Architect & 3 80 14-Jun-16 16-Jun-16
Completed Tasks

Once you have completed a task, you set its 'Complete %' value to 100. This has the effect of preventing the task's
progress bar from being drawn in the object in the Kanban diagram. As well as setting the completion percentage on the
task, you might also want to fill in other information, such as the end date and time expended. It might also be time to
move the object into the next Kanban lane.

Resource Tracking

The Kanban features in Enterprise Architect can be used with any project management method. How the features are
used will depend largely on what works best for individual teams; the teams might be self organizing without any formal
project management controls and other teams might work with a more formal structure. Either way Enterprise Architect
provides a number of facilities that will assist with visualizing resources and their allocations to work items.

Enterprise Architect provides searches to allow you to track resources. You can get a list of tasks that each resource is
working on, overdue tasks, recently completed tasks, summaries, and more. A team or individual can also write their
own custom searches to retrieve any required information from the repository.

Access

Ribbon Construct > Task Management > Active Tasks
Construct > Task Management > Completed Tasks

Construct > Task Management > Track Resources
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Resource Tracking Searches

& Find in Project

®5tartF‘agE Finu:linl-"ru:uject x

Resource Tracking - | | 30 Day Resources = | <5earch Term=

Resources
Tasks Overdue
|Active Tasks

Drag a column header here to group by that

L] Object Type Scope

Tasks Completed

Recently Finished Tasks

Tasks Ending Today

Tasks Starting Today

Authors with no Active Tasks

30 Day Task Summary (Simplified)

30 Day Task Summary (Full)

30 Day Resources &
30 Day Roles

Search Description

Active Tasks Searches the project for elements with assigned resources, where the end date is in
the future and the percentage completion is less than 100.

The output lists all elements with currently active tasks, and shows the details of the
resource allocation to each task.

Tasks Ending Today Searches the project for elements with assigned resources, where the task end date
is today.

The output lists all elements with tasks ending today, whether the task is complete
or not, and shows the details of the resource allocation to each task.

Tasks Starting Today Searches the project for elements with assigned resources, where the task start date
is today.

The output lists all elements with tasks starting today, and shows the details of the
resource allocation to each task.

Overdue Tasks Searches the project for elements with assigned resources, where the end date is in
the past and the percentage completion is less than 100.

The output lists all elements with overdue tasks, and shows the details of the
resource allocation to each task.

Recently Completed Searches the project for elements with assigned resources, where the end date is in
the recent past and the percentage completion is 100. In the 'Search Term' field,
specify the number of days over which to check back.

The output lists all elements with tasks completed within the specified period, and
shows the details of the resource allocation to that task. The output does not include
tasks that have already been finished in advance of a future completion date.

All Completed Searches the project for elements with assigned resources, where the percentage
completion is 100.
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The output lists all elements with completed tasks, and shows the details of the
resource allocation to each task.

30 Day Task Summary Provides a brief summary of the tasks performed by resources over the previous
(Brief) month.

The output groups tasks with similar project role and calculates for each resource:
the count, the sum of expected time, and the sum of expended time for all tasks that
have started in the last 30 days. To look at or change the master list of project roles
that this search uses for grouping tasks, select Configure > Reference Data >
Project Types > People > Project Roles. Grouping by similar project role means
that, for example, 'Review 1' and 'Review 2' would be grouped together under
'Review' if and only if the current project's list of project roles includes one called

'Review'.
30 Day Task Summary Provides a full summary of the tasks performed by resources over the previous
(Full) month.

The output groups tasks by project role and resource, and lists the count, sum of
expected time, and sum of expended time for all tasks that have started in the last
30 days.

30 Day Resources Searches the project for tasks that have started in the last 30 days where the
resource name matches (fully or partially) the text in the <Search Term>.

30 Day Roles Searches the project for tasks that have started in the last 30 days where the role
name matches (fully or partially) the text in the <Search Term>.

Charts and Dashboards

Enterprise Architect has a sophisticated charting facility that allows a wide range of charts to be created through which
you can visualize and analyze repository information. This is particularly useful with Kanban diagrams and resource
allocations and provides an alternative view of the of Kanban cards, allowing a Product Owner, Project Manager or other
team member to get a visual image of things like the Number of Active Tasks by developer and the Phases the Work
Items are in by developer, the Number of Work Items at each stage of a Kanban Board and much more. The charts can
provide powerful information that will help improve the teams performance and ultimately result in high value product
or service features being available to customers in the shortest possible time frame. Any number of charts can be created
from built-in Patterns but a team is also free to create user defined charts, dashboards and reports.

Example - Active Work Items by Team Member

This bar chart shows the number of active tasks by team member. The names of the team members are listed on the
vertical axis and the Number of Tasks on the horizontal axis. A small numerical value indicates the number of active
tasks allocated to each team member.
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Active Tasks

Ali Evans
Anna Howe
Buck Gold
Carlos Wallace
Carmen McRae
Elinor Dashwood
Eric Burns
Leon Major
Liam Cross
Penny Dark

Peter Ryan

Example - Completed Work Items by Team Member

This compelling bar chart shows the number of work items completed by the members of a team in a particular phase of
the process. The team members are represented on the vertical axis and the number of completed work items on the
horizontal axis. Color has been used to help visualize the work items completed in a given phase; a diagram legend lists
the relationship between color and phase. A small numeric indicator indicates the number of items completed in each
phase for each team member.
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Completed Tasks Last Week

Ali Evans
Alma Cogan
Billy Bunter

Bob Brown

Brett Chambers

Carlos Wallace

Carmen McRae

o
David Kelly
1

e H Test
Donna Campbell i B Rework
Eric Burns - B Review
Ethan Rogers ) H Proposal
Frank Mclver i 1 [ Investigate
Josh Morgan ﬁd@ | B implement

Liam Cross

Nigel Molesworth -
Pat Taylor -
Penny Dark 1

Peter Ryan

Philip Marlowe

Example - Weekly Work Item Summary by Phase

This expressive bar chart provides a weekly summary of the number of Work Items completed by phase. The Phases are
represented on the vertical axis and the Number of Work Items on the horizontal axis. The chart can provide powerful
information that will help improve the teams performance.
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Task Summary (1 Week)
Implement
Investigate |
Proposal |
Review ﬁ
Rework ﬁ
Test |
T T T T T T T T T 1
0 10 20 30 40 50 60 70 80 90
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Related Model Elements

There is a wide range of tools that allow teams to create Kanban diagrams, but Enterprise Architect stands on its own as
a tool that not only allows a team to use the powerful Kanban features but is also a sophisticated platform for managing
the work products of every discipline working on Enterprise, Business or Technology initiatives. This means that instead
of having to access other tools or out-of-date documentation or schedule meetings the information related to a work items
is immediately available inside the same repository. An analyst, developer, tester or other team member working on a
User Story, Feature, or Defect can locate the related Requirements, Business Rules Policies, Standard Operating
Procedures, Strategies, Drivers, Goals, Stakeholders Requirements, Architectural designs, Principles, Programming
Code, Database and Information Schemas, XML definitions, Messages, Test Cases, Applications, Deployment Targets
and Specifications and more.

«goal» —
Provide customers with a
competitive online shopping = [N&<~~— -~ -~~~ ———— hl
experience |
|
|
(from Goals) « tra:ce»
|
|
|
|
|
1
Rules Analyzer «business rule» I «policy» ™
Any person studying who is under The bookstore will provide
_____ the age of 27 with student - ———= discounts to students to
identification is considered a «enforces» encourage learning
notes «trace» student
This is a customer built rules engine
used to manage configuration items, (from Bud/ﬁﬁess Rules) (from Policies)
It has been extended to allow rules to |
be viewed and updated through a |
business web interface. |
i «trace»
]
[ |
«trace» |
'] 1
As A Student | want to I]j REQ117 - The system must provide E
buy books at Academic LI ————= :elmec_hamsm allowing studentsto  [— _ _ _ _ _ |
. «trace» identify themselves «trace»
Prices
Requirement «UserStory»
‘rom Take Orders,
Version: 1.0 Phase: In Progress (7 ) | |
Priority: High
Institution
A\ N < A United States
N
: RS Stanford
N ~
«trace» \\\ Harvard
| RS
| AN
N Student Number
Student Verification E U |
This Requirements diagram
«column» shows a User Story that has
ID: NUMBER(8,2) been added to a Kanban -
INSTITUTION NAME: NVARCHAR(50) diagram expressing the
YEAR: NUMBER(4,2) relationships to a number of
STUDENT NUMBER: VARCHAR2(20) business and technical o) o =
elements.

~

Relating Model Elements

Enterprise Architect allows a user to create any number of connections between model elements using the connectors
that form part of the chosen modeling language. Any item that appears in a Kanban diagram can be dragged onto any
other diagram and then connections can be added. For example a User Story that is coming to the top of a backlog or is
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in a Queue lane in a Kanban diagram could be added to a Business or Stakeholder Requirements diagram and trace
relationships could be added between the User Story and the Requirements indicating which requirements relate to the
Story.

Finding Related Model Elements

The work items in a Kanban board can be related to any other elements in the model, allowing a powerful and expressive
graph to be defined. While it is possible to add your own connections, quite typically other team members working in
related disciplines and parts of the repository will have already added relationships to other model elements which in turn
will be related to still other elements and so on.

These connections can all be visualized in existing diagrams, but a modeller can create a new diagram and place the
work item in the center of the diagram, choosing the Insert Related Elements feature to insert the graph of related
elements that can be configured to draw an expressive diagram reaching out to the very corners of the repository.

This diagram shows the result of using the Insert Related Elements feature to find the important information needed
when working on a User Story.

«goal» —
Provide customers with a
competitive online shopping = <<~ ——"—————~——————— bl
experience |
|
|
(from Goals) « tra:ce»
|
|
|
|
|
1
Rules Analyzer «business rule» I «policy» ™
Any person studying who is under The bookstore will provide
_____ the age of 27 with student T = discounts to students to
o . identification is considered a «enforces» encourage learning
«trace»
This is a customer built rules engine Stucent
used to manage configuration items, (from Bud$655 Rules) (from Policies)
It has been extended to allow rules to |
be viewed and updated through a |
business web interface. |
i «trace»
]
[ |
«trace» |
\'A 1
As A Student | want to REQ117 - The system must provide E
buy books at Academic LI ————= amechanism allowing studentsto  |e= _ _ _ _ _ _|
. «trace» identify themselves «trace»
Prices
Requirement «UserStory»
‘rom Take Orders,
Version: 1.0 Phase: In Progress (7 / | |
Priority: High
Institution
/:\ N < A United States
N
: RS . Stanford
«trace» AN Harvard
i R
| T
N Student Number
Student Verification E U |
This Requirements diagram
«column» shows a User Story that has
ID: NUMBER(8,2) been added to a Kanban -
INSTITUTION NAME: NVARCHAR(50) diagram expressing the
YEAR: NUMBER(4,2) relationships to a number of
STUDENT NUMBER: VARCHAR2(20) businessiandltechnical A») o =
elements.

~
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Managing a Backlog

The Backlog (or Product Backlog, as it is called by some agile methods such as Scrum) is an ordered list of items that
will deliver business value to the customer. It can comprise a heterogeneous list of item types ranging from Features,
User Stories and Requirements (including Non-functional Requirements) to Defects, Changes and more. In fact, in
Enterprise Architect any element can be placed onto a Backlog; the ones that are listed and those that appear in the
Toolbox are simply the most common. The Backlog is an ordered list based on the business value, with the higher value
items percolating to the top of the list. The list is owned and managed by the Product Owner or their equivalent; that is,
someone acting as a surrogate for the customer.

Ordering Items in a Backlog Lane

When working with a one stage workflow the Backlog items will typically be contained in the first lane of the Kanban
and can be dragged to a new location in the lane to change the order of items in the backlog.

Step Action

1 Select the Item to be moved in the Backlog diagram.

2 Drag-and-drop it into a new location in the backlog lane.

Prioritizing a Backlog

The order of the items in the Backlog typically is carefully and thoughtfully determined by the Product Owner and
reflects the business value - the items promising high business value are located at the top. The prioritization of the
Backlog is the Product Owner's responsibility, but it is not decided in isolation from other team members and the Product
Owner relies on access to important information from a range of stakeholders, from senior executive level stakeholders,
business and operation managers, requirements and business analysts down to implementation teams.

A range of strategic diagrams and materials provide a source for many of the prioritization decisions. These include:
Strategy Maps, Business Drivers, Goals and Objectives, and Roadmap diagrams that describe the time-based sequencing
of packages of work. The example Roadmap diagram could be used by the Product Owner as an input to what is of high
priority to the Business, or what has been planned by the Enterprise or Business Architecture teams. The diagram will
prove useful in discussions with both the business stakeholders and the implementers, who can gain a business context
for the work they are completing.
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Unit: Quarterly Product Architecture

| Q3'16 | Q4'16 | Q1'17 | Q2'17 | Q3'17 | Q4'17 | Q1'18 | Q2'1
(I I (I (I (I (I (I I

Academic Titles

Item Real-Time Tracking

Sales and Marketing Dashboards

Warehouse Optimization

Logistics Rationalization

Legend

[:] Planning

E] Implementation

C] Production

Implementers' and other stakeholders' comments will also provide a valuable source of information and input into the
prioritization of the backlog. Enterprise Architect has a Discussion window, which is a highly collaborative facility
through which any team member can enter discussion posts against an element and other users can reply and join the
discussion. This can create a rich and useful tapestry of knowledge that will not only help the Product Owner in deciding
the item's position in the backlog list but will also assist implementers when they are ready to implement the item.

M 4 kM ElementDiscussinns\I\Mndel Chat

As a Stock Manager | want to be able to predict product demand -

= %% Paulene Dean 16-Jun-16 4:35 PM

(1] Is this related to peak demand times like the beginning
of the Academic Year or is it more general?

© Greg Michaols 16-Jun-16 4:38 PM

It is being driven by the upcoming Academic Titles
launch but it applies more generally as well.

Another critical piece of information that will help the Product Owner is the item estimates completed by implementers,
who make their best estimation of how long the item is likely to take. Agile teams using User Stories tend to use Story
Points, but any unit of measure can be used as long as the team agrees upon a standard. Some teams will use actual times
based on units such as number of hours, whilst others will use effort-based estimates. Enterprise Architect has a flexible
and integrated resource allocation facility where team members can add estimates, allowed time, actual times,
completion percentages and more. This will be invaluable for the Product Owner, who might have a broad idea of the
time required to complete an item but who relies heavily on the details supplied by the team. The time estimate can be
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entered in the 'Expected Time' field of the Resource Allocation window.

Resource Allocation

HEHEXS &> BEN @

Resource Raole Resource: Jane Ward = | Start Date:
:Jane Ward Developer || Role or Task: Developer - || End Date:
Pat Taylor C++ Programmer Complete %:
Description | History
Example

05-06-2016
13-06-2016

30 June, 2017

*  BExpected Time: 6
*  Allocated Time: 3
15| *  Time Expended: 2

This diagram shows how a backlog can be defined in a one-stage workflow, allowing items to be dragged and dropped in

a single column to define the order of the items in the backlog.

Backlog

AsaCustomerlwant tobe able
to viewthestatusof my order

Userstory
Validated
High

L -

As aReviewer wantto beable
to beableto addwordsto the
online dictionary

Userstory
Proposed
Medium

L .

Prices for some publishers do
not include internal storage

costs

Defect
Proposed
Low

L .

Ordering Items in a Backlog Diagram

When working with two or three stage workflows the Backlog items are contained in a Kanban board representing the
entire Backlog, allowing them to be moved between lanes from low to medium, high or critical or using any user defined
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lane names or bound property.

Step Action

1 Ensure the Backlog Kanban diagram is open.

2 Select the work item to be prioritized in the diagram.

3 Drag and drop the item into a new location, either in the containing lane or in another lane.
Example

This diagram demonstrates a Backlog diagram in a two or three stage workflow. The entire diagram is used to manage
the backlog and items can be dragged within a lane to define their order in that lane, or between lanes to define their
importance and position in the backlog.

Backlog

'Egh'a'ta' Dizggram: "Bado g’

Low Medium High Critical

As a Customer | want to be
able to read peer reviews for
items before purchasing

UserStory
Proposed
Version: 1.0 Phase: 1.0

al
Prices for some publishers do
not include internal storage
costs

Defect
Proposed
Version: 1.0 Phase: 1.0

(i
As a Warehouse Manager |
want to be able to find
unallocated space for future
dates

!

As a Marking Manager | want
to be have a dashboard that
shows sales by demographics
and regions

UserStory
Proposed
Version: 1.0 Phase: 1.0

F
-
The default purchase date

order should be reversed in all

As a Customer | want to be
able track my item on a map

UserStory
Proposed
Version: 1.0 Phase: 1.0

&

As an operation manager |
want to be able find picking
errors caused by system
glitches

Product reports
UserStory UserStory
Proposed Change Proposed
Version: 1.0 Phase: 1.0 Proposed Version: 1.0 Phase: 1.0

Version: 1.0 Phase: 1.0

Securing a Backlog

The Backlog is a communication tool that insulates the implementers from the need to decide what they should be
working on. It is owned and managed by the Product Owner, who ultimately decides what should be on the Backlog and
the order of the items it contains. It therefore must be secured from inadvertent changes. The implementation team
should have access to the Backlog, but for the purposes of pulling items from a work queue to the In-Progress lane,
which could be continuous flow-based (Kanban) or time-boxed (such as a Sprint). The development team also need to
provide time estimates for the items in the Backlog, which will help the Product Owner decide upon the order of items,
particularly when two or more items have comparable business value. The item with the lowest completion estimate will
typically be given a higher position. Developers are also expected and encouraged to comment on the items in the
Backlog so that the Product Owner can understand any issues or have access to learning from prior initiatives or insights.

Enterprise Architect's security system can be used to lock the Backlog while still allowing people to make the necessary
contributions of time estimates and comments in the form of discussions.

With the Security System enabled and either a group for Product Owners or individual users who are Product Owners
added, a Backlog diagram can be locked by the individual Product Owner user or a member of the Product Owner group.
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This example shows the Backlog being locked by the Product Owner group, but for a repository that is accessed by a
number of Product Owners it could be more expedient to lock the diagram to an individual.

Lock Diagram >

Lock Type

"1 Mo lock, general editing allowed

3 Full lock, no-one may edi

) User lock, locking user may still edit
@ Group lock, locking group may still edit

GrouplD: | Product Owners ~

When the Backlog diagram has been locked by the Product Owner, other team members will be able to view the diagram
but a small red marker to the left of the diagram name in the Project Browser will indicate that it is locked. The Project
Manager will see a blue marker indicating that they have access to edit the diagram.

— Backlog - ‘i]‘ \g"

4 D] Projects -
4d |_] Online Bookstore

4 |_] Project Management

A [ 2 Stage Workflow

Fa Iteration

1 Backlog
£ lteration

Eﬁ Project Browser [@ Resources

Securing a Backlog Diagram

Secure a Backlog diagram, remembering that it can be locked at a user or a group level.

Step Action

1 Locate and select the Backlog diagram in the Project Browser.

2 Right-click on the diagram name and select the 'Lock Diagram' option. The '"Lock Diagram' dialog
displays.

3 Select the 'User Lock' or 'Group Lock' option from the 'Lock Type' list.

4 Select the User, or the Group from the 'Group ID' drop-down list.

5 Click on the OK button to save the changes.
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Notes

e The model must have user security enabled in order to lock the backlog Kanban diagram

e To secure a Backlog a two or three stage workflow is required where the Backlog is a separate Kanban diagram
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Elaboration and Grooming

During the process of prioritizing the backlog and as work items move closer to the top of the Backlog or onto the work
Queue they must be prepared for the In-Progress stages of the workflow - in traditional methods this process is termed
'elaboration’, but is known as 'grooming' in Agile methods. Enterprise Architect has a number of facilities that can assist
with the grooming of work items so that when they are pulled onto an In-Progress lane the right information is available
for an implementor to immediately start work.

Enterprise Architect has a requirement type (or responsibility) that is internal to an element and allows supplementary
and more specific requirements to be added to a Work Item. These requirements are created in addition to the business,
stakeholder, functional and non functional requirements that might exist for the work item.

& UserStory : As A Student | want to buy books at Academic Prices x
[=)- Properties Requirement :
i i General An item needs to be identfied as an academic title
- Rules
- Requirements
- Constraints
E - Scenarios B/ Q E"HE ézl o x2%| = = Req
= R:E|Et3d Status Proposed
""" Ffles Students should not be permitted to buy any titles that are not D'r_mc_”m' MEdi”m
""" [nf= marked as academic so a new property must be added to the item Priority Medium
. . . . Stability Moderate
information model and related tables to categorize these titles. -
Type Functional
Last Updated 17-Jun-16 9:...
Mew Save Delete
Requirement Type BExtemal
An item needs to be identified as an academic title Functional
Student numbers need to be verified Functional
The Academic Price discount needs to be configurable at untime Functional

Cancel Apply Help

There is also a wide range of information that can be entered as Change Management Items for a selected Kanban Work
Item. These items include Changes, Defects, Issues, Tasks, Events, Decisions, Effort, Risk and Metrics, and add rich
additional information that will assist all team members including the Product Owner and the Implementation team.
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DEHEXN® BEN@

lssue Priority MName: The database environments are locked down while the Linux upgrades are being done

Auto

The percentage for the academic pr... Medium Raised by: Greg Nichals - | Raised: 15-06-2016 - Status: | Mew -

éThe database environments are loc.. High Completed by: - | Completed: [] - Phorty: |Hgh -
Wersion / 1D: 160663CEE1ISS Copy ID

Description | History
BIU&-IEEI <@

There is a Linux Operating system project in progress for the next couple of
weeks and all non critical database changes have been frozen during this
period. This will mean that the addition of the Student Verification table and
associated stored procedures will have to be delayed. A replica environment
E i = will he huilt on another server to allow develonment to continue.

af& Defects ag"g’l:hanges afg’ Events ag"g’ Decisions pf’ Issues

Enterprise Architect also has an Element Browser that is a convenient tool for viewing all the related information about
an element in a single place. The Element Browser can be kept open as a docked window and items can be selected in a
Kanban diagram, List, Gantt chart or the Project Browser, and the Work Item's specific information will be displayed.
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Element Browser O =
As A Student | want to buy books at Academic Prices
O Operations
EI Attributes
Iil Linked Features
[ Tagged Values
4 Constraints
3 The solution must use existing stored procedures where applicable
4 Requirements
The Academic Price discount needs te be configurable at runtime
Student numbers need to be verified
An itern needs to be identified as an academic title
4 Files
[l E:\Projects\Online BookStore\RequirementsiList of Academic Institutions.dsx
4 Relationships
q'-h Abstraction:Student Verification [Table]
*-, Abstraction:Rules Analyzer [Component]
*.. Abstraction:REQ117 - The system must provide a mechanism allowing students to identify themselves [Requirement]
q'-h Motelink: [Mote]

Scenarios

~

Maintenance
4 Changes
=8 [ Mew ] Academic Institutions need to register for discount
4 Issues
3 [ Mew ] The database environment are locked down while the Linux upgrades are being done
0 [ Verified ] The percentage for the academic price discount has not been set by the product team
4 Decisions
) [ Verified ] Mo need to cite or validate a student card
Iil Testing
4 Project Management
4 Resource Allocation

T8 [30%:] Pat Taylor: C++ Programmer
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Alternate Views

Enterprise Architect is a powerful modeling platform that can be used by any number of stakeholders ranging from high
level executives to implementation teams, providing a variety of communication devices suitable for each stakeholder
group. There are three other views of a Kanban diagram that will be appealing to many stakeholders, particularly project
managers, schedulers, development managers and product owners; these can be viewed by simply toggling from view to
view:

e  Gantt View
This view provides a visualization of the work items and the assigned resources in a Gantt Chart, which is
particularly useful for people who might be more familiar with this more traditional representation or who want to
get an overview of the schedule of tasks

e List View
This view is a spreadsheet representation, where the work items are the rows and the properties and Tagged Values
are the columns

e Traceability Window
This view helps a team member to quickly review dependencies and other relationships between work items to any
depth, and to locate the items in other diagrams

Switching between Views

A Kanban diagram, like all diagrams, can be switched to an alternative view and, once in this view, can be switched to
any other view without affecting the underlying layout of the diagram.

Step Action

1 Ensure the diagram is the active tab or has focus.

2 Ribbon: Design > Diagram > Gantt View > List View > Standard View

0 =0 5

New Manage Toolbox
- 5 Gantt View

7 List View

Diagram

Context Menu: Gantt View | List View | Diagram View

Gantt View

The Gantt View provides a traditional Gantt Chart in the form of bar chart representing the scheduling of the work items
including: their start and finish times and the percentage complete. It is a graph that provides a time oriented view of the
work items and is useful for project managers and project schedulers ot other team members who want to view all the
work items in a single view.
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?g Kanban Diagram: "1 stage workflow"

Element
p
(=] I As A Student | want to buy books at Academic Prices
& Pat Taylor

(=] [ As a Customer | want to be able to add new orders ...
ﬁ' Paulene Dean

=) I As a Customer | want to be able to rent an item for ...
z‘ Faulene Dean

(=] L4 As a Reviewer | want to be able to be able to add a...
& Pat Taylor

(=) 2 As a Sales Representative | want to be able to view ...
ﬁ' Jane Ward
ﬁ Pat Taylor

(=] L4 As a Warehouse Manager | want to be able to dete...
& Yuki Kotabashi

Status

pe)

Proposed

Proposed

Proposed

Proposed

Proposed

Proposed

June 2016 -
Roleor T... | C... = | @ | 15 | 16 | 17 | 18 | 1
el
| q
C+= Prog... 30% [E— S —
L
Business... 10% S ———
Test Analyst 75 % (]
| 4 A
C+= Prog... 63% ' —
Developer 15 % ||
C+=Prog.. 7% [ ]
r A
Test Analyst 85 % [ [E——
-
4 111 4

Access

Ribbon

Design > Diagram > Gantt View

Context Menu

Right-click on diagram background | View as Gantt

List View

The List View provides a spreadsheet like visualization of the work items and their properties and Tagged Values. It
allows properties to be viewed and compared across the entire corpus of work items that make up the diagram and allows
properties such as status to be edited inline using drop-down lists of values where they apply. It also has a clever
mechanism that allows the list to be grouped by property down to any number of levels and a filter that is useful when
wanting to restrict the view of work items with a particular property or name - for example all work items relating to the

Warehouse Manager.
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fg Kanban Diagram: "1 stage workflow"
BEXSRE A kB &-RPT®
.
Priority
¥ Mame ¥  Priority * Phase ¥ Status ¥ Type * Modified 7
Je £ J L e Je
—| Priority: Critical
As a Customer | want to be able to add new orders to existing ones if they hav... Critical In Progress Proposed Defed 17-Jun-16
=I Priority: High
L] As an Administrator | want to be able to have a maintenance window to updat... High In Progress  Validated Requirement 17-Jun-16 =
vl Asa Customer | want to be able to view the status of my order High Backlog Validated Reguirement 17-Jun-1&
E As A Student | want to buy books at Academic Prices High [~ InProgress Proposed Reguirement 17-Jun-16
. . High
~| Priority: Medium m'
The Online Shop web site country drop down list is missing a number of small ... !_ow Done Proposed Defect 14-Jun-16
] As a Reviewer | want to be able to be able to add and edit rules in the online ... Medium In Progress  Proposed Requirement 17-Jun-16
] As aSales Representative | want to be able to view historical leads Medium In Progress  Proposed  Requirement  17-Jun-16
L] Asa Customer | want to be able to delete items from my order before it is ship... Medium Queue Approved Requirement  17-Jun-16
L] As a Reviewer | want to be able to be able to add words to the online dictionary Medium Backlog Proposed Requirement 17-Jun-16 -
Access
Ribbon Design > Diagram > List View
Context Menu Right-click on diagram background | View as List

Traceability Window

The Traceability Window provides an insightful view of how a work item is connected to other elements in the model
including other work items and how these connected elements are themselves connected down to any level. It is a general
purpose mechanism and so can be used with any type of element but is particularly useful when working with Kanban
boards and for product owners and other team members who need to understand the dependenies between work items
and to find the related information that will help with the analysis, grooming, testing and implementation of a work item.
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Traceability O =

6 & @ i -

A Az A Studert | want to buy books at Academic Prices -
A -+ needed by

A Student Verfication
[ --+ dependson
4 £] Rules Analyzer
A -+ depends an
A Any person studying who is under the age of 27 with student identification is considered a student
A -+ needed by
[+ REQ117 - The system must provide a mechanism allowing students to identify themselves
I &l Rules Analyzer

A -+ depends an

A The bookstare will provide discounts to students to encourage leaming
A -+ needed by
Any person studying who is under the age of 27 with student identification is considered a student
A -+ depends an
A Provide customers with a competitive online shopping experience
A -+ needed by
[+ REQ014 - Shopping Basket
[+ The bookstare will provide discounts to students to encourage leaming
[ REQD12 - Provide Online Sales -

Access

Ensure a Work Item is selected in a diagram or other view.

Ribbon Design > Impact > Traceability
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Other Processes and Methods

Kanban is not a process in traditional classification but more of a way of visualizing work items, and a method for
creating efficiencies and ensuring customer value is delivered as soon as possible. Kanban can be used in isolation or in
combination with any existing processes, including Scrum, Iterative and Incremental and Waterfall Processes. Each of
these processes has their place and can be used with Kanban even though much of the literature about process is
currently focused on iterative families of processes such as Agile.

The compelling thing about Kanban is that it provides a visualization of the flow of Work Items from the ideas stage
through to delivering demonstrable value to the customer transparently to every team member.

Scrumban

Scrumban is a hybrid methodology combing aspects of Scrum and Kanban. Scrum teams can typically work with the
same process they have always used, including Sprints, Standups, Retrospectives and Demos, but incorporate Kanban as
a way of visualizing the Work Items, allowing just-in-time planning and benefiting from being able to set
Work-In-Progress (WIP) Limits. The work items that have been selected for the Sprint or Iteration can be pulled from a
Backlog Kanban board onto the Queue lane of an Iteration Kanban board.

Using Scrumban overcomes limitations or issues that some Scrum teams experience such as: excessive time required in
Sprint planning, a loss of focus due to implementers working concurrently on too many User Stories, Defects or other
items and information being forgotten over the period of the Sprint. The built-in one, two or three stage workflows would
all be suitable for Scrumban but a team is free to define their own workflow, create their own Kanban boards and define
their own lanes and sub-lanes.

In Progress

Theresa Moranti

Pat Taylor
iy

As a Sales Representative | want to be able
to view historical leads

UserStory
Version: 1.0
Medium

Pat Taylor
I 1 (+=Progra...

As A Student | want to buy books at
Academic Prices

UserStory
Version: 1.0
High

Pat Taylor
E 1 (+=Progra..

Benjamin Hutton

o
The Online Shop web site country drop
down list is missing a number of small
countries

Defect
Version: 1.1
Medium

Benjamin Hutton
el te=Progra...

&<

As a Customer | want to be able to delete
items from my order before it is shipped

UserStory
Version: 1.0
High

Benjamin Huttan
e 1 Applicatio..

@
As a Reviewer | want to be able to be able
to add and edit rules in the online grammar
checker

UserStory
Version: 1.0
Medium

Theresa Moranti
Iy /1 (#+Progra...

@

Stock levels on financial reports don't
include returned items

Defect
Version: 1.1
Low

Theresa Moranti
= 1 lava Progra...

Iterative Methods

Iterative and incremental methods have been in use since the mid nineteen seventies and have been incorporated into a
number of waterfall processes as well as being used in isolation These processes can all benefit from the use of Kanban
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diagrams as a way of visualizing the work items in an iteration and any number of Kanban diagramscan be created to
manage concurrent iterations.

Project Browser O =

= Multi Iteration Workflow -4 4

A || Multi lteration Workflow .
o Backlog

Bz Iteration One
o Iteration Two
| Backlog
1 Iteration One
] Iteration Two
[ [] Defects
A || User Stories

Waterfall

Waterfall or modified methods have been in use since the mid nineteen-seventies and have been baked into a number of
standards particularly in industries such as the military, aviation, travel and finance where outcomes typically need to be
determined in advance of a development cycle. Waterfall methods are often used when requirements are locked down
and scope is determined in advance, the product is stable and the technology platforms are well known and understood.

These processes can all benefit from the use of Kanban diagrams as a way of visualizing the work items as they flow
from phase to phase.
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Task Management

In the life cycle of a project, there are various non-technical tasks that are vital to the successful management and
completion of the project, such as allocation of resources and allocation of time to the tasks and to meetings. Enterprise
Architect helps you as a project manager or as a team member to record and monitor such tasks.

Facilities

Enterprise Architect provides a range of project management facilities as described in this table.

Facility Description

Manage Project Resources Resources are the people who work on a project. You can assign roles and allocate
tasks to them, which helps you to track effort and estimate time to complete tasks.
You can also define the effort, risks and metrics to support resource management.
You add, modify and delete resources using the Resource Allocation window.

The Gantt View In Enterprise Architect, you can visualize elements and assigned project resources
easily in a Gantt Chart format, to review the breakdown of work for a specific
project and for specific sections of the project. The Project Gantt View illustrates a
project schedule by showing the start and finish dates of assigned resources, so that
you as Project Manager can quickly see the current project status using the
percent-complete bar shading and the percent-complete, resource name and status
columns. Information can be filtered, and overdue items can quickly be highlighted
and identified. You can also access specialized versions of the Gantt View from
diagrams, Packages and the Personal Tasks list.

Project Task Allocation A particular feature of the Project Gantt View is the facility to review the allocation
of work to elements in the project, focusing on either the elements that require
work, or the resources required to perform the work.

Review Personal Tasks Using the Personal Tasks view, each team member can record, review and manage
their personal work within the project.

Project Management Enterprise Architect provides four specialized windows to help you to define each
Windows of the management quantities associated with an element in the model, namely:

e Resources - the people who work on a project, who can be assigned roles and
allocated tasks

e  Effort - the effort expended in work on the element
® Risks - the risks associated with the element, and

e  Metrics - the metrics measured for an element
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Project Resources

Resources are the people who work on a project. They can be assigned roles and allocated tasks, which enables tracking
of effort and estimation of time to complete. You also define the effort, risks and metrics to support resource
management.

Resources are added, modified and deleted using the Resource Allocation window.

Access

Ribbon Construct > Task Management > Resource Allocation

Uses

Use to

Allocate a resource to an element.
Record additional project management information for an element.
Obtain a report of resource allocation details.

Configure Project Management data and populate the drop-down lists used on the Project Management widows.

Notes

e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have 'Configure Resources' permission to update and manage project
resources, effort, metrics and risks
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Resource Allocation

In developing a model, people (or resources) in a number of roles might perform tasks on model structures. As a Project
Manager, you can assign resources to tasks on elements (including Packages) in the model, planning and monitoring the
work that they do within the timeframe you have allocated for that work to be completed. You can do this using the
Project Management and/or Project Gantt View facilities.

Access

First, select an element, then:

Ribbon

Construct > Task Management > Gantt > Element View > right-click on element >
Assign Resource, or

Construct > Task Management > Resource Allocation > : (o New

Enter resource allocation details for an element

Option

Resource

Role or Task

Start Date

End Date

(c) Sparx Systems 2015 - 2017

Action

Either:

e Type in the name of the resource being assigned to work associated with the
element, or

e  Click on the drop-down arrow and click on the name of the resource

If you want to assign more than one resource to the task on the element, you follow
a slightly different procedure.

Either:
e Type in the role name or task performed by the selected resource, or

e  Click on the drop-down arrow and click on the role performed by the resource

This field defaults to today's date.
If you want to assign a different start date for the task:
1. Click on the drop-down arrow.

2. Ifnecessary, click on the Left or Right Arrow to select the previous or next
month.

3. Click on the appropriate day of the month as the start date.
The field immediately changes to the selected date.

This field defaults to today's date.

If you want to assign a different end date for the task:

1. Click on the drop-down arrow.

2. If necessary, click on the Right Arrow to select the next month.
3. Click on the appropriate day of the month as the end date.

The field immediately changes to the selected date.
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Complete % If the task is already in progress, type in the current percentage completion.

Expected Time Type in the number of whole time units the task is expected to take. (The value
must be an integer, so you cannot record part units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of

hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Allocated Time' and 'Time Expended' fields.

Allocated Time Type in the number of time units the task can be spread over. (The value must be an
integer, so you cannot record part units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of

hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Expected Time' and 'Time Expended' fields.

Time Expended (When the task is eventually 100% complete, you will type in the number of time
units it actually took. The value must be an integer, so you cannot record part
units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of

hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Expected Time' and 'Allocated Time' fields.

Description Type (and, if you prefer, format) a description of the work being done by the
resource (this text is also displayed in the Notes window, but it cannot be edited in
that window).

History (As the task progresses, you add text to this tab to record the activities, progress,
problems and outcomes of the task. This text is also displayed in the Notes window,
but it cannot be edited in that window.)

(Toolbar icon) (Project Management window toolbar.)
Click on this icon to save the data you have entered and to add the entry to the

Resource list in the left column of the window.

OK ('Assigned Resources' dialog.)

Click on this button to save the data you have entered, and close the dialog.

Cancel ('Assigned Resources' dialog.)

Click on this button to discard the data you have entered, and close the dialog.

Help ('Assigned Resources' dialog.)
Click on this button to display the Assign Multiple Resources Help topic.

Notes
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e Ifyou allocate resources to Use Cases, the information you enter contributes to the Use Case Estimation calculation
for estimating the project size in terms of time, resources and cost

e To edit existing Resource Allocation items for this element, click on the required item in the:
- 'List' panel to the left of the window, in Item mode
- List, in List mode
- Project Management folder in the Element Browser window - if this window is not displayed, click on the
Browse Element icon
in the Project Management window toolbar; resource allocation item icons have an 'R' in the bottom right corner

e To delete existing Resource Allocation items for an element, click on the item and click on X in the window
toolbar
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Assign Multiple Resources

When you have a large unit of work associated with an element - such as a Package element - you might want to assign
several resources to that element to perform that unit of work. You can assign each person individually, but if the
resources have the same role or task you can assign all of them together in one operation, using the 'Assigned Resources'
dialog.

Access
First, select an element, then:

Ribbon Construct > Task Management > Gantt > Element View > right-click on element >
Assign Resource, or

Construct > Resource Allocation > : o (to show List view) > Right-click > Add
New

Assign multiple resources to an element

Option Action

Resource (To assign a single resource, simply type in the name or click on the drop-down
arrow and select the name from the list. In Project Management, it is simpler to
assign single resources directly through the Resource Allocation window.)

For multiple resources, click on the D button to display the 'Assign Resource'
dialog.

1. Select the checkbox against each resource to assign to the element; to select all
resources listed, click on the Select All button.

2. Click on the OK button to close the dialog and add the selected resources to the
'Resource’ field.

The 'Resource’ field now shows the selected resources, but grayed out. The
drop-down arrow also is not active. To change the resources in the field, click on

the D button again and select/clear the appropriate checkboxes.

Role or Task Either:
e Type in the role name or task that is common to all the selected resources, or

e  Click on the drop-down arrow and click on the role that is common to all the
resources

Start Date This field defaults to today's date.
If you want to assign a different start date for the task:
1. Click on the drop-down arrow.

2. If necessary, click on the Left or Right Arrow to select the previous or next
month.

3. Click on the appropriate day of the month as the start date.
The field immediately changes to the selected date.
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End Date This field defaults to today's date.
If you want to assign a different end date for the task:
1. Click on the drop-down arrow.
2. Ifnecessary, click on the Right Arrow to select the next month.
3. Click on the appropriate day of the month as the end date.
The field immediately changes to the selected date.

Complete % If the task is already in progress, type in the current percentage completion.

Expected Time Type in the number of time units the task is expected to take. (The value must be an
integer, so you cannot record part units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of

hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Allocated Time' and 'Time Expended' fields.

Allocated Time Type in the number of time units the task can be spread over. (The value must be an
integer, so you cannot record part units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of

hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Expected Time' and 'Time Expended' fields.

Time Expended (When the task is eventually 100% complete, you will type in the number of time
units it actually took. The value must be an integer, so you cannot record part
units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of

hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Expected Time' and 'Allocated Time' fields.

Description Type (and, if you prefer, format) a description of the work being done by the
resources (this text is also displayed in the Notes window, but it cannot be edited in
that window).

History (As the task progresses, you add text to this tab to record the activities, progress,
problems and outcomes of the task. This text is also displayed in the Notes window,
but it cannot be edited in that window.)

Apply Click on this button to apply the changes to the currently-displayed element on a
diagram, without closing the dialog.

New Click on this button to clear the fields on the dialog so that you can define a new
resource allocation.

Previous Click on this button to display the previous resource record in the sequence.

Next Click on this button to display the next resource record in the sequence.
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OK Click on this button to save the data you have entered, and close the dialog.
Close Click on this button to discard the data you have entered, and close the dialog.
Help Click on this button to display this Help topic.

Notes

e When the resource details are displayed on the Project Gantt Chart or 'Project Management' dialog, each resource
has their own record containing, initially, the same data; however, each resource can be monitored and their progress
recorded separately

e Ifyou assign resources that are already in a multiple resource assignment to the selected element, a prompt displays
for you to confirm that you are updating the assignment of that resource, or now omitting that resource from the
current assignment
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Effort Management

In Enterprise Architect, the Project Manager can allocate effort (as time) to work on a given model element. To select the
element to which to allocate effort, click on the required element in the Project Browser.

Access

Ribbon Construct > Change Management > Effort : New

Enter effort allocation details for an element

Option Action
Effort Type the name or a brief description of the effort.
Type Type in the effort type or click on the drop-down arrow and select the type. The

selection list is drawn from the global Effort Type list, but any new efforts you type
in this field are not added to the list.

Time Type in the amount of time the effort is expected to expend.

<notes> Type in any additional notes or description of this effort.
This text is also displayed in the Notes window, but it cannot be edited in that
window.

risksave Click on this icon in the Project Management window toolbar to save the new effort
definition.

Notes

e To edit existing Effort items for this element, click on the required item in the:
- 'List' panel to the left of the window, in Item mode
- List, in List mode, or
- Project Management folder in the Element Browser window - if this window is not displayed, click on the
Browse Element icon
in the Project Management window toolbar; effort item icons have an 'E' in the bottom right corner

e To delete existing Effort items for an element, click on the item and click on X in the window toolbar

e  Although Enterprise Architect does not currently provide detailed reports on effort within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on effort information you enter
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Risk Management

In Enterprise Architect, the Project Manager can allocate the possible weighting of defined risks to work on a given
model element, which might impact work on that element.

To select the element to which to allocate risk weightings, click on the required element in the Project Browser.

Access

Ribbon Construct > Change Management > Risks : New

Enter risk details for an element

Option Action
Risk Type the name or a brief description of the risk.
Type Type in the risk type or click on the drop-down arrow and select the type. The

selection list is drawn from the global Risk Type list, but any new risks you type in
this field are not added to the list.

Weight Defaults to the weighting for the defined type. You can change this weighting if
necessary.

<notes> Type in any additional notes or description of this risk.

This text is also displayed in the Notes window, but it cannot be edited in that
window.

risksave Click on this icon in the Project Management window toolbar to save the new risk
definition.

Notes

e  The risks described here are not the same as those represented by Risk elements; the risks are properties of a single
element, whilst the Risk element represents something that can impact a range of other elements

e Ifyou select a global risk type from the "Type' drop-down list and the associated "Weight' field is empty, the default
Weight value is allocated to the 'Weight' field on the Risks window

e To edit existing Risk items for this element, click on the required item in the:
- 'List' panel to the left of the window, in Item mode
- List, in List mode
- Project Management folder in the Element Browser window - if this window is not displayed, click on the
Browse Element icon in the Project Management window toolbar; risk item icons have an 'Ri' in the bottom
right corner

e To delete existing Risk items for an element, click on the item and click on X in the window toolbar
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e  Although Enterprise Architect does not currently provide detailed reports on risks within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on risk information you enter
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Metrics

The Project Manager can allocate the possible weighting of defined metrics to work on a given model element.

To select the element to which to allocate a metric weighting, click on the required element in the Project Browser.

Access

Ribbon Construct > Change Management > Metrics : New

Enter metric details for an element

Option Action
Metric Type the name or a brief description of the metric.
Type Type in the metric type or click on the drop-down arrow and select the type. The

selection list is drawn from the global Metric Type list, but any new metrics you
type in this field are not added to the list.

Weight Defaults to the weighting for the defined type. You can change this weighting if
necessary.

<notes> Type in any additional notes or description of this metric.
This text is also displayed in the Notes window, but it cannot be edited in that
window.

risksave Click on this icon in the Project Management window toolbar to save the new

metric definition.

Notes

e Ifyou select a global metric type from the 'Type' drop-down list and the associated "Weight' field is empty, the
default Weight value is allocated to the 'Weight' field in the Metrics window

e To edit existing Metric items for this element, click on the required item in the:
- 'List' panel to the left of the window, in Item mode
- List, in List mode
- Project Management folder in the Element Browser window - if this window is not displayed, click on the
'Browse Element' icon in the Project Management window toolbar; metric item icons have an 'M' in the
bottom right corner

e To delete existing Metric items for an element, click on the item and click on X in the window toolbar

e  Although Enterprise Architect does not currently provide detailed reports on metrics within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on metric information you enter
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Effort Types

When setting up the project management parameters for monitoring work on elements, you can create types of effort to
add to the global list of effort types that can be assigned to any element in the model. You can also select and edit
existing effort types. The global list of effort types displays in the 'Type' drop-down list on the 'Effort' page of the Project
Indicators window.

Access
Open the 'Project Indicators' dialog using one of the methods outlined here, then select the 'Effort’ tab.

Ribbon Configure > Reference Data > Project Types > Project Indicators : Effort

Add a new effort type to the global list
Click the 'New' button to define a new Effort type
Option Action

Effort Type the name of the effort type. (Or, to edit an existing effort type, click on the
effort name in the Defined Effort Types panel.)

Description Type a short description of the effort type.

Weight Type the default weighting to apply to the effort type.

<note> Type any additional information on the effort type.

Save Click on this button to save the changes that you have made to the dialog.
New Click on this button to clear the data fields ready to define a new effort type.
Delete Click on an entry in the Defined Effort Types panel, and click on this button to

immediately delete the effort type.

Close Click on this button to close the 'Project Indicators' dialog. If you have not saved
your changes, the system prompts you to save or abort those changes.

Notes

e  Although Enterprise Architect does not currently provide detailed reports on effort within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on effort information you enter

e You can transport effort types between models, using the 'Configure > Model > Transfer > Export Reference Data'
and 'ITmport Reference Data' ribbon options
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Metric Types

Enterprise Architect enables you to add a metric type to the global list of metric types that can be assigned to any
element in the model. The global list of metric types displays in the 'Type' field drop-down list on the Metrics window.

Access
Open the 'Project Indicators' dialog using one of the methods outlined here, then select the 'Metric' tab.

Ribbon Configure > Reference Data > Project Types > Project Indicators : Metric

Add a new metric type to the global list
Click the 'New' button to define a new Metric
Option Action

Metric Type Type the name of the metric type. (Or, to edit an existing metric type, click on the
metric name in the Defined Metrics panel.)

Description Type a short description of the metric type.

Weight Type the default weighting to apply to the metric type.

<note> Type any additional information on the metric type.

Save Click on this button to save the changes that you have made to the dialog.
New Click on this button to clear the data fields ready to define a new metric type.
Delete Click on an entry in the Defined Metrics panel, and click on this button to

immediately delete the metric type.

Close Click on this button to close the 'Project Indicators' dialog. If you have not saved
your changes, the system prompts you to save or abort those changes.

Notes

e Although Enterprise Architect does not currently provide detailed reports on metrics within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on metric information you enter

e You can transport metric types between models, using the 'Configure > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options
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Risk Types

Using Enterprise Architect you can add a risk type to the global list of risk types that can be assigned to any element in
the model. The global list of risk types displays in the "Type' field drop-down list on the 'Risks' page of the Project
Indicators window.

Access
Open the Project Indicators window using one of the methods outlined here, then select the 'Risk' page.

Ribbon Configure > Reference Data > Project Types > Project Indicators : Risk

Add a new risk type to the global list
Click on the New button to define a new Risk
Option Action

Risk Type Type the name of the risk type. (Or, to edit an existing risk type, click on the risk
name in the 'Defined Risks' panel.)

Description Type a short description of the risk type.

Weight Type the default weighting to apply to the risk type.

<note> Type any additional information on the risk type.

Save Click on this button to save the changes that you have made to the dialog.
New Click on this button to clear the data fields ready to define a new risk type.
Delete Click on an entry in the 'Defined Risks' panel, and click on this button to

immediately delete the risk type.

Close Click on this button to close the 'Project Indicators' dialog. If you have not saved
your changes, the system prompts you to save or abort those changes.

Notes

e  Although Enterprise Architect does not currently provide detailed reports on risks within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on risk information you enter

e You can transport risk types between models, using the 'Configure > Model > Transfer > Export Reference Data' and
'Tmport Reference Data' ribbon options
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Project Task Allocation

Using the Project Gantt View, you can review the allocation of work to elements in the project, focusing on either the
elements that require work, or the resources required to perform the work. The view primarily shows information that is
entered through other windows and dialogs, but once a record exists in the view you can edit it and, for example, add to
or change the resources on an element.

Access

Ribbon Construct > Task Management > Gantt
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The Project Gantt View

In Enterprise Architect, you can visualize elements and assigned project resources in a Gantt Chart format, to review the
breakdown of work for a specific project and for specific sections of the project. The Project Gantt View illustrates a
project schedule by showing the start and finish dates of assigned resources, so that a Project Manager can quickly see
the current project status using the percent-complete bar shading and the percent-complete, resource name and status
columns. Information can be filtered, and overdue items can quickly be highlighted and identified.

You can also access specialized versions of the Gantt View from diagrams, Packages and the Personal Tasks list.

Access

Ribbon Construct > Task Management > Gantt

Gantt View

This example shows four resources, two of whom are working in different capacities on one task, and two on another
task. The resource names and roles are listed in the left panel of the chart, together with the actual percentage completion
of each person's work on the task. In the right panel of the chart, completed work is indicated by the green section of the
bar, work yet to be completed but not yet due is indicated in blue, and work not completed and overdue is indicated in
red (as a result of the option to highlight overdue work being applied).

(P start Page |3 Project Gantt View X
August 2015

Resource Status Role or Task Complete = = = = = = b = o
e e e e
@ & Cathy Ballantine F |
Department Costi... Approved  Project Manager 10 % | ———————]
= & David Jones = N
Element Test Stat... Approved Developer 0% | —
= & Fred Hopkins F |
Element Test Stat... Approved  Java Programmer 70% [| § ———]
= l?{' Sally Cooper p_—=

Department Costi... Approved VB Programmer =T —

M 4 » » | Resource \View, ElementView Report View

Tabs of the Gantt View

The Project Gantt View has three tabs, the first two of which use the Gantt chart itself to show the progress of work
against the resources performing the work or the elements having the work performed on them. (Other variations of the
Gantt chart do not have these separate tabs.)

View Detail
Resource View When you initially open the Gantt View, it defaults to the 'Resource View' tab, in
which the focus is on the current commitments of each allocated resource in the
project.
Element View The Element View lists the elements in the project that have resources assigned to

them, and the resources assigned to each element.
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A Resource report shows how your resources are deployed in your project,
displaying a list of all elements that have resources allocated to them.

Report View

Gantt View Facilities

The facilities of the Project Gantt View are common to the Resource and Element Views, and in some cases to all three
tabs, as described here.

Option

Display tasks for today
only, or for another day
only

Display the properties of
the element to which a
resource is assigned

Display the Resource
Allocation details for an
element or resource

Display the Resource
Allocation records for an
element

Assign a new resource to
an element

Change the scale of the
display
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Action

Right-click on the display and select the option:

e 'Show Only Active Tasks for Today' - to show only tasks that are in progress
today

e 'Show Only Active Tasks for Other Day' - to show only tasks that were in
progress on a specific day in the past, or that are scheduled to be in progress on
a day in the future; a calendar dialog displays from which you select the day to
examine

Right-click on the element entry and select the 'Show Element Properties' option.
The "Properties' dialog for the element displays.

Right-click on the entry and select the 'Show Task Properties' option.

The 'Assigned Resources' dialog displays; you can edit the details and, if necessary,
change the resource allocated to the element.

(Also available in the Report View.) Right-click on the entry and select either of the
context menu options:

e 'Show Element Resource Allocation window' (if the window is closed or
hidden)

e 'Find Task in Element Resource Allocation window' (if the window is visible
but showing the details of another element)

The Resource Allocation window displays, with the details of the selected entry
shown in the fields and the other resource allocations for the element listed in the
left-hand panel.

You can edit the details and, if necessary, change the resource allocated to the
element.

Right-click on an element in the display, and select the 'Assign Resource' option.

The 'Assigned Resources' dialog displays; complete this as for the Resource
Allocation window.

By default, the Gantt Chart shows periods of time in units of days of the month,
each date column being approximately one centimetre wide. Weekends have a
darker fill color.

You can change the scale of the date columns by clicking on the column header,
pressing Ctrl and rolling the mouse wheel. As you do this:

e At one extreme the date columns expand to approximately 2.5 centimetres, and
the date header shows the full date in dd/mm/yyyy format

e Rolling to the other extreme changes the scale of the column from date through
week, labeled month, numbered month and labeled year to numbered segments
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Change the duration of a
task, on the Gantt Chart

Grouped work

Filter the display to
exclude elements by status

Filter the display to include
elements having certain
properties

Filter the display by Start
or Completion date
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of a decade

This allows you to represent a wide range of tasks on a single chart and to condense
or expand the view - in conjunction with filters - to investigate the short term and
longer term work clearly.

You might want to make broad adjustments to the timeline of an event, which you
can easily do on the Gantt Chart itself. For example, the resource is ill, or another
resource has taken over other tasks that the resource was allocated to. In neither
case has the task itself changed, but in the first case the resource needs a longer
elapsed time in which to complete the task, and in the second they have less other
work to do and can finish the task sooner.

To make these adjustments, you simply drag the right end of the time bar further or
back along the chart. This changes the task end date to wherever you drag the time
line to, and adjusts the division into complete and incomplete/overdue work to
maintain the percentage completion value. The work time allocated to the task does
not change.

If you drag the left end of the time line, this moves the whole line without changing
its length or proportions; you are just indicating that the task started earlier or later
and will finish earlier or later by the same amount of time.

A resource is likely to be allocated to several tasks either simultaneously or
consecutively. In the Resource View the tasks assigned to a resource are grouped
under the resource name, and a narrow group bar displays in gray on the chart
against the name, spanning the period from when work is scheduled to begin on the
first task to when work is scheduled to finish on the final task.

Similarly, a body of work, represented by an element, might involve several
resources starting and finishing at different points. The resources are grouped under
the element name and the group bar displays on the chart against the element name,
spanning the period from when the first resource is scheduled to start work to when
the last resource is scheduled to complete work on the task.

If any adjustments are made that impact the initial start point or final completion
point of the work, the end of the group bar automatically adjusts. If any task or
resource in the group is overdue, the group bar turns red to reflect that there is a
potential problem in the allocated work.

(This feature takes effect under your user ID.)
Right-click on the window and select the 'Apply Element Status Filter' option.

The 'Excluded Status Types' dialog displays; select the checkbox against one or
more statuses to exclude elements having those statuses from the list.

You can select every checkbox at once by clicking on the Select All button, and
clear all selections by clicking on the Clear All button.

Click on the OK button to immediately apply the filter, which stays in effect until
you specifically change it.

Right-click on the list and select the 'Show Filter Bar' option.

The Filter Bar displays underneath the heading bar. Type a text string in the field
above a column to immediately filter the list for entries that have the text string in
the values in that column.

To delete a filter string altogether, click on the blue cross at the right of the field.

If you no longer want to use the filter bar, right-click on the list and select the 'Hide
Filter Bar' option.

The display default is to show current tasks for which the end date has not yet
occurred. Right-click on the list and select one of the options:
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Identify overdue tasks

Display ONLY overdue
tasks

Refresh the report

Reposition the Gantt chart
to automatically show the
end date of a selected
allocation

Reposition the Gantt chart
to show the start date or
end date of an allocation,
or today's date

Locate the element in the
Project Browser

Send a Model Mail to the
resource

Save an image of the Gantt
chart to file
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e 'Include Completed Tasks Within the Last ..." - to display incomplete tasks and
tasks completed only within the specified period; you can set this period to 7,
30 or 90 days, or you can include all completed tasks, or hide all completed
tasks

e 'Include Future Tasks Starting in ..." - to display current incomplete tasks and
completed tasks (depending on the setting of the 'Include Completed Tasks
Within the Last ..." option) and future tasks that have been recorded and are due
to start within the next period; you can set this period to 7, 30 or 90 days, or
you can show all tasks that have been recorded but are not yet due to start

Right-click on the display and select the 'Display Highlight For Overdue items'
option and one of its sub-options:

e 'Show in Red' - to display the uncompleted percentage of the task bars for
overdue items on the Gantt chart in red

e 'Show in Red to Current Date' - to extend the task bars of the overdue items to
today's date, and display them in red

e 'None' - to cancel any overdue item highlighting that has been set

Right-click on the display and select the 'Show Overdue Items Only' option.

The display shows only those items for which the end date has passed but that are
not 100% complete. These items do not have red highlighting.

Right-click on the entry and select the 'Refresh' option.

The content of the display is refreshed and collapsed to element or resource level.

Right-click on the display and select the 'Go to | Auto Sync with Task End Date'
option.

Whilst this option is selected (with a tick next to it), whenever you click on an
allocation the display adjusts to show the end date of the task in the center of the
chart.

Right-click on the entry and select the required option:

e 'Go To | Task Start Date'

e 'Go To | Task End Date'

e 'Go To | Today's Date'

The display shifts to put the required date in the center of the chart.

(Also available in the Report View.) Right-click on the element name and select the
'Find in Project Browser' option.

The area of the Project Browser containing the element is brought into focus and
expanded, and the element is highlighted.

It is possible to send a Model Mail directly from the Project Gantt View to a
selected resource if the resource's Author name matches their:

e Enterprise Architect security user ID (Security has been enabled) or
e  Their workstation login ID (Security has not been enabled)

Right-click on the resource or one of their activities and select the "Post Model
Message' option. This opens a Model Mail message addressed to the resource, for
you to complete and send.

Right-click on the tab and select the 'Save Image to File' option.

The 'Save As Image' dialog displays, on which you specify the file name, location
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and graphics file type to save to.

Save an image of the Gantt Right-click on the tab and select the 'Copy Image to Clipboard' option.

chart to the clipboard You can paste the image from the clipboard into your preferred graphics package.

Notes

e Jtems in the list pane can be filtered; right-click on the column headings in the list pane to toggle the Filter Bar
between hidden or shown, or to edit the filter
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Resource View

The Resource View' tab shows the current commitments of each allocated resource in the project as a list of allocation
records and a Gantt chart of the progress of the allocations.

The display initially shows the resources and their overall commitment; click on the 'plus-box' to the left of the name of
the resource to expand the entry to show the elements and the allocation period for each element.

The display shows both complete allocations and those that are still in progress; an internal filter hides completed
allocations two weeks after the end date, and incomplete allocations one month after the end date. Tasks you can perform
include checking the:

e Dates on which specific resources or all resources are currently allocated
e FElements to which each resource is allocated

e Dates on which a resource is allocated to work on a specific element

e General progress of the resource in completing the work

e  Specific details of the allocation of a resource to an element and task or role

Access

Ribbon Construct > Task Management > Gantt : Select the 'Resource View' tab
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Element View

The "Element View' tab of the Project Gantt View lists the elements in the project that have resources assigned to them. It
shows the resources assigned to each element as a list of allocation records and as a Gantt chart of the progress of the
allocations. An allocation can be partial, in that a role or task is assigned but no specific resource has been identified.

The display initially shows the elements and their overall resource commitment; click on the "plus-box' to the left of the
name of the element to expand the entry to show the resources and the allocation period for each resource. You can then:

e  Check the dates on which specific elements have resources currently allocated

e Check which resources are currently allocated to an element

e Assign further resources to the element

e  Check the dates on which a resource is allocated to work on a specific element

e  Check the general progress of the resource in completing the work

e Check the specific details of the allocation of a resource to an element and task or role

The display shows both complete allocations and those that are still in progress; an internal filter hides completed
allocations two weeks after the end date.

The 'Element View' complements the 'Resource View' and 'Personal Tasks View' of work allocation on the project.

Access
Ribbon Construct > Task Management > Gantt > Element View or
Design > Diagram > Gantt View
Context Menu Right-click on a diagram | Switch to Gantt View

Project Browser | Right-click on Package | View as Gantt
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Report View

The Report View shows how your resources are deployed in your project, displaying:

A list of all elements that have resources allocated to them, and the type of each element

The resource allocated, and the role played by that resource

The start and end dates of the allocation

The time allocated, expected and expended

The percentage completion of the allocation

You can tailor the displayed information by:

Hiding columns of information

Grouping types of information

Filtering the data by status

Filtering the data by start date or end date

Filtering any column to show only a specific value

Having displayed the information you require, you can print it.

Access

Ribbon

Report View Options

Option

Run the report

Adjust column headings

Group entries by column
heading

Filter columns

(c) Sparx Systems 2015 - 2017

Construct > Task Management > Gantt : Select the 'Report View' tab

Action

Click on the first icon in the Report View toolbar (the rotating arrows).

The report results display.

If you have the report open for a while, you can update the information; either:
e Run the report again or

e Right-click on the content and select the 'Refresh' option

Drag and drop column headings into the sequence you require.

Right-click on the column headings and select the 'Field Chooser' option, to add or
remove columns using the 'Field Chooser' dialog.

Right-click on the column headings and select the 'Enable Group Box' option, to
cluster the report information according to your preferred hierarchy of column
headings.

Either:
e Click on the third toolbar icon from the right (the spy glass), or
e Right-click on the column headings and select the 'Toggle Filter Bar' option
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The filter field displays at the top of every column.

Type in whatever text string you require in the appropriate column to filter the
report to show only entries containing that text string in that column.

Filter by degree of In the first field in the toolbar, click on the drop-down arrow and select one of these
completion values:

e 'All'- Display all entries regardless of degree of completion

e 'Completed' - Display only those entries where the allocation is 100%
completed

e 'Above cut-off' - Display only those entries that are more than a certain
percentage complete

e 'Below cut-off' - Display only those entries that are less than a certain
percentage complete

In the second field in the toolbar, either type a threshold value or increment to the
value using the up/down arrows, to set the percentage completion for the
'Above/Below cut-off' options.

Filter according to start/end Click on the fourth toolbar icon from the right (the funnel).

date The "Resource Filters' dialog displays.

In the 'Start Date' and/or 'End Date' field, click on the drop-down arrow and select
the appropriate qualifier:

o 'After
e 'Before'
e 'Equal To'

e 'Not Equals'

In the date fields, click on the checkbox to activate the fields and either type in the
day, month and year or click on the drop-down arrow to select the date from a
calendar.

The fields have an AND relationship; an entry must satisfy both date criteria before
it is displayed.

Print the report Either:
e  Click on the second toolbar icon from the right (the printer) or
e Right-click on an entry in the report and select the Print' option

The 'Print' dialog displays, on which you specify the printer to use and the
characteristics of the print job.
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Progress Bars

Progress bars are horizontal bands that show the degree of completion of a task or process. They give a quick indication
of the current status of, for example, projects, tasks or budgets, which can be useful for checking how close a task or
project is to completion or if a project is coming close to hitting its total allowed budget.

Progress bars can be especially useful in large projects that consist of multiple smaller projects, as you can display within
one element separate bars showing the degree of completion of each sub-project and of the main project, giving you an
overview of progress at a single glance. Separate elements within the diagram can contain further progress bars for the
metrics of the individual projects, adding levels of detail that can, again, be assessed in a brief review.

In Enterprise Architect, progress bars are implemented using Tagged Values on elements.

Release 10.2.5

Total Completion
e— ] 59%

Budget
Total Cost
Eeeeeessss——w ] $270,000

Projects

Project Anubis
—— |
Project Hades

/N

Project Hades Project Anubis
Cost Cost
eeeesss——— | $150,000 eeeee———— | $180,000
Progress Progress
[ ——— ] 37% complete —— ]| 82% complete

Tasks Tasks

Deploy Deploy
[ ] I ]
Design Design
——— ]
Help Topics Help Topics
[— ] —— ]
Implement Implement
[ ———— ]
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Using Progress Bars

You can add progress bars to any element that can show compartments and that can display any numerical value within a
range, when displayed on a diagram.

Progress bars can be used to display things such as:
e  The current progress of a task or project
e How much of project's budget has been used

By default a progress bar will display a value between 0 and 100 (inclusive); however, it is possible to adjust both the
minimum and maximum values to set any range of values required.

This illustration shows an example of a default progress bar:

Project Alpha

Progress

— ]

Creating a Progress Bar using a new Tagged Value
Use this procedure to create a progress bar using a simple Tagged Value that you create immediately from scratch.
Step Action

1 On a diagram, create an element that can display compartments (such as a Requirement or Feature) and
add a simple Tagged Value to it.

2 From the Tagged Values window open the tag's notes and add 'Type=ProgressBar;' (including the
semi-colon) and then click on the OK button.

Tagged Value Note x

Type=ProgressBar;

(o] 8 Cancel Help

(You can add further options to the Tagged Value, as described in the Additional Progress Bar Options
table.)

3 Click on the element and either press Ctrl+Shift+Y or right-click and select the 'Features and Properties >
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Feature and Compartment Visibility' option. The 'Feature and Compartment Visibility' dialog displays.

4 Select the 'Tags' checkbox in the 'Show Element Compartments' panel, then click on the OK button.
The progress bar will now be shown on the element on the diagram, with the Tagged Value name above
the bar.

5 In the Tagged Values window, indicate progress by typing a number between 1 and 100 into the 'Value'

field for the tag. On the diagram, the appropriate length of the progress bar is filled in green.

Creating a Progress Bar from the 'UML Types' dialog

You can also define a progress bar Tagged Value from the 'UML Types' dialog that can then be applied to any element,
without having to set the Tagged Value notes each time.

Step Action

1 Select the 'Configure > Reference Data > UML Types' ribbon option to display the 'UML Types' dialog
and click on the 'Tagged Value Types' tab.

2 In the 'Tag Name' and 'Description’ fields, type a name and description for the Tagged Value. In the

'Detail' field type the option parameters and their values for the Tagged Value. Click on the Save button
and on the Close button.

= UML Types
- Stereotypes o Current project et
Tagged Value Types Tag Name: Description: urrent project completion
.. Cardinality Values
’ Detail:
Type=ProgressBar;
Text=#Value#%:;
New Delete
Defined Tag Types:
Type Description
Completion Current project completion

(The option parameters are described in the Additional Progress Bar Options table.)

3 Select the 'Start > Tagged Values' ribbon option to open the Tagged Values window (if it is not already
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On a diagram select an element, then in the Tagged Values window click on the S~ (New Tagged

Value) button.

In the 'Tag' field of the Tagged Value dialog, click on the drop-down arrow and select the Tagged Value
you created in step 2, then click on the OK button.

4 On the diagram, right-click on the element and select the 'Features & Properties | Feature and
Compartment Visibility' option to display the 'Feature and Compartment Visibility' dialog.

5 Select the 'Tags' checkbox and click on the OK button.

6 In the Tagged Values window, change the number in the 'Value' field a few times, clicking off the field
each time. Notice the effect this has on the progress bar.

Additional Progress Bar Options

A default progress bar will show the Tagged Value name and reflect values in the range 0-100. You can change the range
values if required, and display text to the right of the bar if more information has to be provided. Use these parameters to

enhance the progress bar.

Parameter

MinVal

MaxVal

Text
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Description

Use the MinVal option to set the lowest allowed value to be represented on the
progress bar.

e Syntax: MinVal=<number>;

A progress bar with the setting MinVal=10; will start at 10. Values lower than 10
will not be shown on it.

If a maximum value (MaxVal) has been defined, the progress bar will show any
values between MinVal and MaxVal (inclusive); otherwise, the maximum value
will default to MinVal + 100. So, if MinVal=10, the progress bar can show values
between 10 and 110 (inclusive).

Use the MaxVal option to set the highest allowed value to be represented on the
progress bar.

e Syntax: MaxVal=<number>;

A progress bar with the setting MaxVal=300; will show values up to and including
300. Values higher than 300 will not be shown.

If a minimum value (MinVal) has been set, the progress bar will show any values
between MinVal and MaxVal (inclusive); otherwise the minimum value will
default to 0. So, if MaxVal=300 the progress bar can show values between 0 and
300 (inclusive).

Use the Text option to define additional text to display on the right hand side of the
progress bar. The text might be a resource name or the current take up of the total
allowed budget of a project.

e  Syntax: Text=<text>; - displays the defined text string, such as 'David Brown's
Tasks'

e Syntax: Text=#Value#; - displays the value of the progress bar Tagged Value,
such as '462' (where the Tagged Value name itself might indicate the type of
value or unit)
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e Syntax: Text=<text> #Value# <text>; - displays the value of the progress bar
Tagged Value with text before and/or after it, such as '$<value> of $100,000'

This illustration shows a number of examples of using the Text option.

Project Alpha
Development
[ ——— ] $150,000 / $300,000
Implement
————— | Terry
Marketing
———— | $250,000 / $300,000
Progress
——— ] 80% Complete

Compartment By default, progress bars in an element display together in a separate compartment
from other types of Tagged Value (provided that the diagram and/or element are set
to display tag compartments).

When there are several progress bars on an element, each relating to a different
factor of the project, it can become harder to distinguish between them. In these
cases it is possible to set the progress bars to display in specific compartments in
order to increase clarity. This also provides an additional level of labeling. So you
might have an element relating to costs, and two or more compartments that
indicate costs of different departments, where the department name is reflected in
the compartment name. Or compartments that each contain two or more progress
bars indicating, say, the costs and percentage completion of tasks in each
department.

e Syntax: Compartment=<name>;

To add multiple progress bars to the same compartment simply give the progress
bars the same compartment name.

This example shows the element from the Text parameter example, but with the use
of compartments to aid in readability.

Project Alpha
Progress
———— ] 80% Complete
Budget
Development
[ —— ] $150,000 / $300,000
Marketing
——— |  $250,000 / $300,000
Tasks
Implement
| Terry

Progress Bars with MDG Technologies

Progress bars can also be created within MDG Technologies to define a consistent set of progress bars for use with
multiple projects.
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Personal Tasks

Using the Personal Tasks view, you can record and manage your personal work within the project. This view displays
information based upon your identity as a defined Author on the project.

Access
Ribbon Start > Today > My Gantt
Work Category
Category Detail
Allocated Work Presents a Gantt chart on which you record the work that you are currently engaged
in.
Project Tasks Enables you to monitor and maintain the work tasks that have been assigned to you,

or that you have created yourself.
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Review Allocated Work

The 'Allocated Work' tab lists the elements to which your model Author ID has been allocated as a resource, where your
Author ID is the same as:

e  Your Enterprise Architect security user ID, if security has been enabled, or
e Your workstation login ID if security has not been enabled
For each element, the tab:

e In the left-hand panel lists the roles or tasks assigned to you as a resource on that element, for which the 'Complete
%' field value is less than '100'

e In the right hand panel displays a Gantt chart showing your progress in performing each role or task

You can add further work items for an element through the 'Allocated Work' tab; however, you cannot delete any
records. A record is no longer listed when the 'Complete %' field value is '100'".

You or your supervisors can also add records through the Resource Allocation window.

Access

Ribbon Start > Today > My Gantt > Allocated Work

Select Allocated Work options

Option Action

Review element properties Double-click on the element name.

(Alternatively, right-click on the element name and select the 'Show Element
Properties'option.)

The "Properties’ dialog for the element displays; review the pages as required.

Review resource task Double-click on the task item.
details (Alternatively, either:
e Double-click on the progress bar for the item on the Gantt chart, or

e Right-click on the task or role name and select the 'Show Task Properties'
option)

The 'Assigned Resources' dialog displays, which has the same content, format and
functions as the Resource Allocation window, in 'Item' mode.

Should it be necessary to reassign the item to another resource, click on the
drop-down arrow on the 'Resource’ field and select the appropriate 'Author ID';
when you save the changes, the item no longer appears in the list of tasks assigned
to you.

Create new task item Right-click on the element name and select the 'Add Resource' option.

The 'Assigned Resources' dialog displays, with your Author ID in the grayed-out
'Resource’ field.

Complete the dialog as for the Resource Allocation window.
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Refresh display to
incorporate changes

Display the Resource
Allocation records for the
element

Display tasks for today
only, or for another day
only

Filter the display by Start
or Completion date

Identify overdue tasks
amongst the items

Display ONLY overdue
tasks

Locate the element in the
Project Browser
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Your work item can be edited in a number of places in Enterprise Architect, such as
the Project Task Allocation window and the 'Resource Allocation' tab; the element
to which it is assigned can be edited in these and many other areas.

To refresh the display with any changes made elsewhere, right-click on the display
and select the 'Refresh’ option.

Right-click on the entry and select either of the options:

e 'Show Element Resource Allocation window' (if the window is closed or
hidden)

e 'Find Task in Element Resource Allocation window' (if the window is visible
but showing the details of another element)

The Resource Allocation window displays, with the details of the selected entry
shown in the fields and the other resource allocations for the element listed in the
left-hand panel.

You can edit the details and, if necessary, change the resource allocated to the
element.

Right-click on the display and select the option:

e 'Show only Active tasks for today' - to show only tasks that are in progress
today

e 'Show only Active tasks for another day' - to show only tasks that were in
progress on a specific day in the past, or that are scheduled to be in progress on
a day in the future; a calendar dialog displays from which you select the day to
examine

The display default is to show current tasks for which the end date has not yet
occurred. Right-click on the list and select one of the options:

e 'Include Completed Tasks Within the Last ..." - to display incomplete tasks and
tasks completed only within the last period; you can set this period to 7, 30 or
90 days, or you can include all completed tasks, or hide all completed tasks

e 'Include Future Tasks Starting in ..." - to display current incomplete tasks and
completed tasks (depending on the setting of the option above) and future tasks
that have been recorded and are due to start within the next period; you can set
this period to 7, 30 or 90 days, or you can show all tasks that have been
recorded but are not yet due to start

Right-click on the display and select the 'Display Highlight For Overdue items'
option and one of its sub-options:

e 'Show in Red' - to display the uncompleted percentage of the task bars for
overdue items on the Gantt chart in red

e 'Show in Red to Current Date' - to extend the task bars of the overdue items to
today's date, and display them in red

e 'None' - to cancel any overdue item highlighting that has been set

Right-click on the display and select the 'Show Overdue Items Only' option.

The display shows only those items for which the end date has passed but that are
not 100% complete. These items do not have red highlighting.

Right-click on either the element or the work item and select the 'Find in Project
Browser' option.

The appropriate Package hierarchy expands in the Project Browser, and the selected
element is highlighted.
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clipboard
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Right-click on the display and select the 'Go to | Auto Sync with Task End Date'
option.

Whilst this option is selected (with a tick next to it), whenever you click on an
allocation in the 'Allocated Work' tab the display adjusts to show the end date of the
task in the center of the chart.

Some items might operate over a long period of time, and you might not be able to
display the complete progress line for the item in the Gantt chart.

To locate the start point, expected end point, or today's date on the progress line for
an item, right-click on either the item or the progress line and select the appropriate
option:

e 'Go To | Task Start Date'
e 'Go To | Task End Date'
e 'Go To | Today's Date'

The Gantt chart shifts left or right to position the required point in the center of the
display.

If scripts have been defined for analyzing the task data, click on the 'Scripts' option
to display the list of script names. Click on the appropriate name to execute the
script on the selected item or items.

You can refine the list of work items to show only those containing text that
matches the filter item.

Right-click on the tab and select the 'Show Filter Bar' option.
The filter bar displays at the top of the panel; type in the filter text.

As you type, the items listed and the Gantt chart are filtered to show only items
where the item names match the text string.

The filter does not operate on the element names.

If you do not want to use the filter, right-click on the tab and select the 'Hide Filter
Bar' option.

Right-click on the tab and select the 'Save Image to File' option.
The 'Save As Image' dialog displays, on which you specify the file name, location

and graphics file type to save to.

Right-click on the tab and select the 'Copy Image to Clipboard' option.

You can paste the image from the clipboard into your preferred graphics package.
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Monitor Your Tasks

The "Project Tasks' tab lists the tasks that you either:
e Own, or
e  Are assigned to

You can use the tab to review the status and progress of tasks that you are responsible for, and to modify and filter the
display of task information. You can create the tasks through the:

e 'Project Tasks' tab itself
e 'Tasks' tab of the Project Status window

e  Project Tasks view of the Resource Calendar

Access

Ribbon Start > Today > My Gantt > Project Tasks

Make selections from the options

Option Action

Add or Modify a task You add or modify a task through the 'Task Detail' dialog, which displays when you
double-click on an entry (edit) or blank line (create).

Delete a task Right-click on the message and select the 'Delete’ option.

You are prompted to confirm the deletion.

Select columns Right-click on the column headings and select the 'Field Chooser' option, which
enables you to add or remove specific columns from the display.

You can also click on the column headings and drag them across the header bar to
reposition the columns in a different sequence.

Reorganize tasks in the list Either:

e Click on the column heading and click on the arrow head to list items in order
or reverse order, or

e Right-click on the column headings and select the 'Enable Group Box' option
to organize the messages into groups

You can also use the filter bar to filter the display on an appropriate column value,
such as the value New' in the 'Status' column; to display or hide the filter bar,
right-click on the column headings and select the 'Toggle Filter Bar' option.

Set persistent Status filter Right-click on the tab and select the 'Set term filter' option.

The 'Filter by Status' dialog displays, which enables you to select to list tasks of any
status or only of one specific status.

The filter you set persists when you close the Personal Tasks window or exit from
Enterprise Architect.
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Print the task list Right-click on the tab and select the 'Print List' option.

The 'Print' dialog displays, on which you specify the local printer and the print
characteristics.
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Project Management Windows

The Project Management windows help you to define these quantities associated with an element contained in the model:

Resources - the people who work on a project, who can be assigned roles and allocated tasks

Effort - effort expended in work on the element

Risks - risk associated with the element

Metrics - metrics measured for an element

A separate window displays for each of the four quantities.

Access

Ribbon

Toolbar Options

Construct > Task Management > Resource Allocation
Construct > Change Management > Effort
Construct > Change Management > Risks

Construct > Change Management > Metrics

You can operate on individual items in any of the four Project Management windows, using the Project Management
toolbar.

1 H B X 2 B 5 @

Icon

New
Save

Save As New

Delete
Sort
Print

Browse Element

Show/Hide Properties

Help
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Action

Create a new item.
Save changes to an item.

Duplicate an existing entry.

You must change an item's Role for this to become enabled.
Delete an item from the list.

Sort the items in the list into alphabetical order.

Print item data from the list.

Display the Element Browser window for the selected element, to list and select the
project management items for the element.

Swap between detailed and summary window styles.

Show help contents for this window.
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Notes

e  C(Click on an element in the Project Browser to switch to the project management information for that element in the
Project Management windows

e  The windows have two formats:
- List mode - provides a detailed list showing several columns of information
- Item mode - a summary list plus an editor to add or edit information for a single selected item

e Toggle between these modes using the Show/Hide Properties button in the window toolbar

e  Columns in the item list can be reorganized, added, removed, grouped, filtered and sorted using the options provided
in the List Header facilities

e Right-click on the list to view the context menu, which you can use to add and delete items in the window
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Testing
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It is important in any project to perform quality control of both the process and the output of the project; Enterprise
Architect provides several facilities for testing and validating your model structure and content, including Integration
with the unit testing tools JUnit and NUnit.

Facilities

Facility Description

Create and manage test scripts for model elements. Explore the Testing Ul
supporting unit, integration, scenario, system, acceptance and inspection tests.

Model Validation Check UML elements, diagrams or Packages against known UML rules (identified
in configuring validation) and constraints defined within the model, using the
I Object Constraint Language (OCL). Define your own checks against custom rules
I . and constraints. See the Model Validation topic for more information on setting up

model validation rules.

Testpoint Management Pass or fail application tasks, viewing test results in real time as the program
executes and results are saved. See the section on Testpoints management for more

. J information on setting up and running automated tests.
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Test Management

Enterprise Architect is not only a UML Modeling environment, it is also a complete Test Management environment.
Using Enterprise Architect you can create and manage test scripts for model elements, developing unit, integration,
scenario, system, acceptance and inspection tests; these can include test cases generated from xUnit testing and Testpoint
Management.

You can also import tests from other elements, generate them from scenarios, and generate test documentation and
reports; you can indicate the presence of tests on an element by displaying test information on the element in a diagram.

It is simple to attach even complex tests to any model element. Keeping the model elements and the testing
documentation in one integrated model significantly improves the communication between the test-team and the software
developers and architects.

The system's detailed search facilities make it easy to find failing test cases, test cases not run and test cases that have
been passed; using the testing and search capabilities, it is easy to navigate through the model and quickly locate problem
spots, design flaws and other critical issues.

Test Tasks

Tasks Detail

Create Tests You create tests in the 'Testing Workspace', and using the 'Test Details' dialog.
Typically, you create:
e  Unit tests for things that are being built, such as Classes and components
e Integration tests to test how components work together
e System tests to ensure the system meets business requirements
e Acceptance tests to test user satisfaction

e Scenario tests to test the end-to-end suitability and functionality of the
application

e Inspection tests for peer review of things that are being built using a well
defined process

These test categories are otherwise referred to as test Classes; the type of Class is
internally identified by a value from 1 to 6 corresponding to the test types in the
order listed above.

Using Tests Tasks that you might perform when working with tests include:
e Import a scenario as a test
e  Move or copy tests between test classes
e Import a test from other elements
e Import a responsibility or constraint as a test
e (Create a maintenance item from a test
e  Generate a Test Details report

e Show test script compartments
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e (Create test documentation

Notes

e Most of the tasks identified above relate to a tests for a single element

e You can make a set of tests available to a number of elements by performing the above tasks on a Test Case element
and then associating that Test Case with each of the other elements; the Test Case element also helps to make tests
more visible in diagrams, the Project Browser, windows and searches
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Create Test Records

When you need to create or edit a test record on an element, for any of the six types of test, you can do so using either the
Testing window in Item mode, or the 'Test details' dialog. The 'Test details' dialog displays when you select the New'
option or double-click on a test entry on the Testing window in List mode.

Whichever type of test you are recording, and whichever dialog you use, you complete effectively the same fields.

Access

Ribbon ) ) Ty )
Construct > Testing > Test Windows > <test class> : (toolbar 'New' icon)

Keyboard Shortcuts 3
Alt+3 : (toolbar New" icon)

Create a test record

Field/Button Action
Test Type the name of the test. This can be any alphanumeric text string you want to
use.
Auto As an alternative to typing in the name, click on this button to insert predefined

auto-counter text.

If you already have some text in the 'Test' field, it is over-written by the
auto-counter text.

Status Click on the drop-down arrow and select the value indicating the current status of
the test (Not Run, Pass, Fail, Deferred and Canceled).

Type Click on the drop-down arrow and select the value indicating the type of test (Load,
Regression or Standard).

Class Type This field defaults to the class (type) of test selected in the drop-down field at the
(Class on the Test details' left of the Testing window Toolbar - Unit, Acceptance, Scenario, Integration,
dialog) Inspection or System.
If you are creating a different class of test, click on the drop-down arrow and select
that class.
Run By Click on the drop-down arrow and select the name of the person who ran the test.
Checked By Click on the drop-down arrow and select the name of the person who checked the
test run.
Last Run Click on the drop-down arrow and select the date on which the test was last run.

(Run Date on the 'Test
Details' dialog)
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Result ('Test Details' dialog) Click on the drop-down arrow and select the value indicating
the results of the test (Not Run, Pass, Fail, Deferred and Canceled).

Append to Test Result ('Test Details' dialog) Select this checkbox to reproduce the Test Run data in the
'Results' tab for the test.

Description Type a description of the test; you can format the text using the Notes toolbar at the
top of the field.

This text is also reflected in the Notes window, but cannot be edited there.

Input Type in the input data provided to the test; you can format the text using the Notes
toolbar at the top of the field.

This text is also reflected in the Notes window, but cannot be edited there.

Acceptance Criteria Type the acceptance or test success conditions; you can format the text using the
Notes toolbar at the top of the field.

This text is also reflected in the Notes window, but cannot be edited there.

Results Type the results of the last test; you can format the text using the Notes toolbar at
the top of the field.

This text is also reflected in the Notes window, but cannot be edited there.

Previous ('Test Details' dialog) If earlier test records exist, click on this button to reset the
fields to the values of the previous test record.

Next ('Test Details' dialog) If you are looking at an earlier test record, click on this button
to reset the fields to the values of the next most recent test record.

New ('Test Details' dialog) Click on this button to clear the fields so that you can enter
the information for a new test record.

OK ('Test Details' dialog) Click on this button to save the new or changed data and
close the dialog.

Close ('Test Details' dialog) Click on this button to close the dialog without saving the
new or changed data.

Apply ('Test Details' dialog) Click on this button to save the new or changed data without
closing the dialog.

Notes

e  On the 'Test Details' dialog, you can add multiple test cases in one batch using the New button and Apply button

e On the 'Test Details' dialog, if you have several tests of one category (such as Unit or Integration), once you have
saved a new test (click on the Apply button) or displayed an existing test, you can work backwards and forwards
through any other existing tests of that category, by clicking on the Previous button and Next button

e To display an existing item for editing, click on the item in the left-hand panel in Item mode, or double-click on the
item in List mode to display the 'Test Details' dialog

e  To delete an item, right-click on it on the Testing window and click on the Delete icon in the window toolbar; in

(c) Sparx Systems 2015 - 2017 Page 106 of 159 Created with Enterprise Architect



User Guide - Project Management 30 June, 2017

response to the confirmation prompt, click on the Yes button

e A further possibility for editing and deleting items is to right-click on items in the Element Browser and select menu
options there; to access an item through the Element Browser, click on the Ez icon in the Testing window toolbar
and click on the required item in the Testing folder in the Element Browser window

e To change the element for which to create or edit test items, click on the element in the Project Browser

e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have 'Manage Tests' permission to add, update and delete test records
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Working On Test Records

Creating and working on element Test records is quick and convenient, using the Testing window or Workspace. If the
Testing window is open, when you select an element in a diagram or in the Project Browser, the tests for that element are
immediately listed in the window ready for modification or addition. The window provides several facilities for creating
and managing the test records.

Access
Ribbon Construct > Testing > Test Windows > <test class>
Keyboard Shortcuts Alt+3
Facilities
Facility Detail
Window Formats The Testing window has two formats - [tem mode and List mode.

e [tem mode provides a list on the left hand side from which you select a test
record, the details of which then display in the fields in the rest of the window;
you can edit these fields directly

e List mode consists of a list of test records with summary data distributed across
the columns; you cannot directly edit these fields

To toggle between the modes, click on oy (the Show/Hide Properties button) in the

window toolbar.

Adding New Items To add new items, click on the 'New' icon in the window toolbar. In:

e [tem mode, this clears the fields for new data

e List mode, this displays the 'Test Details' dialog, which you complete in the
same way as the Testing window in Item mode

Applying Automatic On the Testing window in Item mode, or on the 'Test details' dialog, you can apply

Naming/Numbering an automatic naming/numbering convention that you have previously defined, to
each new test record. To do this, simply click on the Auto button next to the 'Test'
field.

If you already have some text in the '"Test' field, it is over-written by the

auto-counter text.

Test Types The six types of test you can create records for are:

e  Unit tests - to test Classes, Components and other elements as programmers
build them

e Integration tests - to test how the constructed components work together

e  System tests - to test that the system performs the right business functions
correctly

e  Acceptance tests - to test the system against user requirements
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e  Scenario tests - to test the application with real-world situations and scenarios;
an end-to-end test of all functions

e Inspection tests - to record peer reviews using a well defined process

The fields you complete for each type of test are identical. You can filter the
display to show tests of a specific type, or all types of test, using the drop-down
arrow at the left hand end of the toolbar.

Element Browser You can also use the Element Browser window to select and display specific items

on the Testing window; click on the Bz icon in the Testing window toolbar to
display the Element Browser, open the Testing folder and the appropriate test type
group (one of the six listed in Test Types), and select the required test record.

Notes

e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have Manage Tests permission to add, update and delete test records

e The Testing window can be docked to the application workspace

e  Columns in the List mode can be reorganized, added, removed, grouped, filtered and sorted using the options
provided in the List Header facilities
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Move or Copy Tests Between Test Classes

After you define a test within one test class (Unit, Integration, System, Acceptance, Inspection or Scenario), you might
decide that the test either is better suited to another test class, or forms a good template for tests in other classes. If so,
you can either move or copy the test to the other classes.

Access
Ribbon Construct > Testing > Test Windows > <test class> > right-click on test to
move/copy
Keyboard Shortcuts Alt+3 : right-click on test to move/copy
Move or copy a test
Step Action
1 Click on the appropriate option - 'Move to' or 'Copy to'.

A list of test classes displays.

2 Click on the test class to which to move or copy the test.

A confirmatory prompt displays.
3 Click on the Yes button to confirm the move or copy.

4 Change the test class selected on of the Testing window to the target class, to check that the test has been
added, and make any necessary changes.

5 If you are copying the test to more than one other test class, repeat steps 1 to 4 for the next class to copy
to.

Notes

e Ifyou move or copy a test into the Scenario class, some unassociated data could be lost
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Show Test Script Compartments

When you have created a Test record, it is useful to make the test visible on its parent element. You can do this by
displaying the test within a Test Script compartment on the element as it displays in a diagram. Any element that is
capable of displaying a compartment, and that has a test assigned to it, can show test scripts in a diagram.

Show the Test Scripts on an element in a diagram

Step Action

1 Open a diagram containing the element with the attached test items.

2 Double-click on the diagram background to display the diagram 'Properties' dialog.
Click on the 'Elements' tab.

3 In the 'Show Compartments' panel, select the 'Testing' checkbox.

4 Click on the OK button to save the setting.
Each test now appears as an item in the test scripts compartment of the diagram element.

Example

JPanel
CCBookClientPanel

bookpanel: CCBookPanel = new CCEBookPanal}
bl_Pnce: JLabel = new JLabel{"Pnca"}

CCBookClentPanel])
GetBook() : CBook
getl) : void

jblnit) : woid
SetBook(CBook) : void
setlI) : void

Acceptance: : (Pass) User Satisfaction

test scripts
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Create Maintenance Item From Test

If an element fails a test, one likely consequence is that a Defect (Issue) item has to be raised in model maintenance to
correct the problem. You can generate this Defect item directly from the test that failed.

Access

Select an element, then use one of the methods outlined here to display the Testing window and show the required class
of tests. Then, in the Testing window:

e Right-click on test | Create a Maintenance Defect from this test

Alternatively, select an element, then open the Element Browser window and within the 7esting folder:

Right-click on test | Create a Maintenance Defect from this test

Ribbon Construct > Testing > Test Windows > <test class> > Right-click on test > Create a
Maintenance Defect from this test

Start > Explore > Element Browser > Right-click on test > Create a Maintenance
Defect from this test

Keyboard Shortcuts Alt+3 : <test class> | Right-click on test | Create a Maintenance Defect from this
test

Alt+9 : Right-click on test | Create a Maintenance Defect from this test

Create a Maintenance item from a test

Step Action

1 The system immediately creates the Defect item and displays a confirmation message box.

Click on the OK button to clear the message.
2 Open the Maintenance window ('Construct > Change Management > Defects > Show Defects Window").
The tab shows a Defect item having the same name as the test. The Description, Input, Acceptance

Criteria and Results texts from the test are all displayed in the Defect's 'Description' tab under separate
headings.

3 Complete the Defect item as necessary - you might provide values for the 'Reported By', 'Status' and
'Priority’ fields.

Notes

e  You can create Maintenance Defect items from several Test items at once; press and hold Shift as you select the Test
items, and then right-click and proceed as above - each selected Test item then generates a Defect item
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Import Scenario as Test

If you are creating a test for a scenario from either a single element or many elements in a Package, you do not have to
manually re-type the scenario details into the test record in the Testing window. You can generate the test into the
'Scenario' tab of one element from one or more scenarios in any element in the model.

Within the Scenario test record, the scenario description is copied to the 'Description' tab. If a scenario contains a
Structured Specification, its Action steps are also copied to the 'Description' tab under the heading 'Structured
Specification'.

Access
Ribbon Construct > Testing > Test Windows > <test class> > right-click on test > Import
element scenario(s) or
Construct > Testing > Test Windows > <test class> > right-click on test > Import
Package scenarios
Keyboard Shortcuts Alt+3 : right-click on test | Import element scenario(s) or

Alt+3 : right-click on test | Import Package scenarios

Import a scenario from a single element

Field/Button Action

Select element If you are copying scenarios from a different element to the target element, click on
the drop-down arrow and select the source element. The list identifies elements that
have scenarios that can be imported.

Otherwise, leave this field blank.

Show related elements only Select this checkbox to restrict the list of selectable elements to those that are
related to the target element.

Limit selection to these If you want to restrict the list of selectable elements to only those of specific types,
Object Types only type in those element types in a comma-separated list.
Refresh Click on this button after changing any of the above field values, to refresh the list

of available elements in the 'Select element' field.

Select items to import Lists the scenarios defined in the source element. Select the scenario(s) to import.
If you do not use the 'Select element' field, any scenarios listed are from the current
element to which this test record belongs.

If you have selected a different element, the scenarios come from that element.

All Click on this button to select all scenarios listed in the 'Select items to import' field.

None Click on this button to clear the selection of scenarios listed in the 'Select items to
import' field.
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Import Click on this button to import the selected scenario(s).

Import scenarios from the elements in a Package

Field/Button Action
Limit selection to these If you want to restrict the selected elements to only those of specific types, type in
Object Types only those element types in a comma-separated list.

This version of the Tmport Scenario' dialog lists all scenarios against all elements in
the Package; it does not enable you to select a specific element, but does enable you
to filter the list of scenarios to those from specific types of element.

Refresh Click on this button after changing any of the above field values, to refresh the list
of available elements in the 'Select element' field.

Select Items to import Lists the scenarios defined in the selected elements in the Package. Select the
scenario(s) to import.

All Click on this button to select all scenarios listed in the 'Select items to import' field.

None Click on this button to clear the selection of scenarios listed in the 'Select items to
import' field.

Import Click on this button to import the scenarios from each element as Scenario tests.

Notes

e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have 'Manage Tests' permission to add, update and delete test records
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Import Test From Other Elements

If you have created useful tests in one element, you can import those tests into any other element through the Testing
window and so avoid having to duplicate the test information manually. You open the Testing window for the empty,
target element and then select the source element that contains the tests to import.

Access
Select target element, then:

Ribbon Construct > Testing > Test Windows > <test class> | Right-click on tests | Import
tests from other element

Keyboard Shortcuts Alt+3 : Right-click on tests | Import tests from other element or
Alt+9 : Testing folder | Right-click on tests | Import tests from other element

Import a test

Field/Button Action

Select element Click on the drop-down arrow and locate and select the source element.

This list identifies elements that have tests that can be imported.

Show related elements only Select this checkbox to restrict the list of selectable elements to those that are
related to the target element.

Limit selection to these If you want to restrict the list of selectable elements to only those of specific types,
Object Types only type in those element types in a comma-separated list.
Refresh Click on this button after changing any of the above field values, to refresh the list

of available elements in the 'Select element' field.

Select items to import Lists the tests defined in the source element. Select the test(s) to import.
If you have not used the 'Select element' field, any tests listed are from the current
element to which this test record belongs. There is no purpose in importing these.

All Click on this button to select all tests listed in the 'Select items to import' field.

None Click on this button to clear the selection of tests listed in the 'Select items to
import' field.

Import Click on this button to import the selected test(s).

Notes

(c) Sparx Systems 2015 - 2017 Page 115 of 159 Created with Enterprise Architect



User Guide - Project Management 30 June, 2017

e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have Manage Tests permission to add, update and delete test records
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Import Responsibility or Constraint as Test

If you are creating a test against a responsibility (internal requirement) or internal constraint of an element, you do not
have to manually re-type the details into the test record in the Testing window. You can generate a testing record on the
element from the responsibility or constraint.

The test record is generated into the test-type tab that you currently have open, and the responsibility or constraint
description is copied to the 'Description' tab for the test record.

Access

Select an element, then use one of the methods outlined here to display the Testing window and show the required class
of tests. Then, in the Testing window:

e Right-click on test list | Import element constraint(s) or

e  Right-click on test list | Import element requirement(s)

Alternatively, select an element, then open the Element Browser and, within the Testing folder:
e Right-click on test of required class | Import element constraint(s) or

e Right-click on test of required class | Import element requirement(s)

Ribbon Construct > Testing > Test Windows > <test class> > Right-click on test list >
Import element constraint/requirement

Start > Explore > Element Browser > Right-click on test of required class > Import
element constraint/requirement

Keyboard Shortcuts Alt+3 : <test class> | Right-click on test list | Import element constraint/requirement

Alt+9 : Right-click on test of required Class | Import element
constraint/requirement

Import a requirement or constraint as a test

Step Action

1 On the 'Import Constraint' or 'Import Requirements' dialog (the two dialogs are identical) review the list of
internal requirements or constraints in the selected element.

2 Click on one of the items to import as a test, or press Ctrl+click on more than one to import several.
Click on the OK button.
Each item is added to the list of tests in the Testing window, on the selected <test-type> tab, as a standard,
'Not Run' test.

3 Edit the items to complete their definition as tests.

Notes
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e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have Manage Tests permission to add, update and delete test records
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Test Documentation

After you have recorded a number of test scripts and results against elements in the model, you can output the
information as a report in Rich Text Format, using the 'Generate Test Documentation' dialog. You can configure which
tests to include or exclude in the report, whether to include child Packages, and the file location to which to generate the
report.

Access
Select a Package, then display the 'Generate Test Documentation' dialog using one of the methods outlined here.
Ribbon Construct > Testing > Test Report

Context Menu Right-click on Package | Documentation | Testing Report
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Maintenance

In the course of your team's work on a model, changes and issues can arise at a number of levels, for problems that apply
system-wide through areas of the model and down to within a specific element. A Change, very broadly, defines an
addition or alteration to a requirement, whilst an Issue identifies either a failure to meet a requirement, or a risk in
meeting the requirement.

There are two mechanisms that can be used to identify a change or issue, and the work required to resolve it:

e  Change and Issue (or Defect) elements - structured comments that identify a problem at system-level, although they
can also be attached to a specific element from which a problem arises; both types of element can be linked by
relationships such as Association, Dependency and Realize to one or more other elements that have to be reviewed,
and for complex problems can form hierarchies or groups

e Maintenance items - properties raised against a specific element and recorded for that element in the Maintenance
window; these provide a distinction between Defects (a failure to meet a requirement) and Issues (a risk factor that
might affect satisfying the requirement) and also include Tasks, which record work items associated with the
element

Maintenance items are very specific, but if an item begins to have a wider impact on other elements or the system in
general, you can translate that item into a Change, Issue, or any other type of element that best identifies the problem
and its solution

Maintenance items are defects, changes, issues, tasks, events and decisions that apply at the model element level. They
are properties of individual model elements that can be used to record and capture problems, changes, issues, tasks,
events and decisions as they arise, and document the solution and associated details.

Maintenance Tasks

Task Area Detail
Maintenance Items - You create maintenance items in the Maintenance window, and using the 'Item
Element-level Details' dialog. Typically you create:

e A defect to record a failure to meet a requirement for the current model
element

e A change to record a change in requirement for the current model element

e Anissue to record a risk factor that might affect the project being recorded for
the current model element

e A task to record work in progress and work outstanding for the current model
element

e An event to record the action taken for the current model element

e A decision to record the choice taken for the current model element

Creating and Editing Tasks that you might perform when working with maintenance items include:

Maintenance Items e Moving or copying maintenance items between maintenance types, or generate
new items of one type from an item of a different type

e (Create elements from maintenance Items
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e Show maintenance items on elements in a diagram
e Add a maintenance item directly to an element via in-place editing

e Generate a report on the status of maintenance items of specific types or all

types
Maintenance - To represent changes, defects and issues that apply to the model you can create
System-level Change and Issue elements with - if necessary - subordinate structures.

To represent issues and tasks that apply to the progress of the project as a whole
and that are not related to model structures, you create Project Status records in
Project Management.
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Working on Maintenance Items

Creating, viewing and modifying the Maintenance items - changes, issues, defects, tasks, events and decisions -
associated with a particular model element is quick and convenient, using the Maintenance window or Workspace. If the
Maintenance window is open, when you select an element in a diagram or in the Project Browser, the Maintenance Items
for that element are immediately listed in the window ready for modification or addition. The window provides several
facilities for creating and managing the Maintenance items.

You can include the maintenance items in the document and web reports generated on your model. The 'Document Setup'
dialog has checkboxes to show or hide element maintenance items.

Access

Ribbon Construct > Change Management > Changes > Show Changes Window
Construct > Change Management > Defects > Show Defects Window
Construct > Change Management > Issues > Show Issues Window
Construct > Change Management > Tasks > Show Tasks Window
Construct > Change Management > Events > Show Events Window

Construct > Change Management > Decisions > Show Decisions Window

Facilities

Facility Detail

Window Formats The Maintenance window has two formats - Item mode and List mode.

e [tem mode provides a list on the left hand side from which you select a
maintenance item, the details of which then display in the fields in the rest of
the window; you can edit these fields directly

e List mode consists of a list of maintenance items with summary data
distributed across the columns; you cannot directly edit these fields

To toggle between the modes, click on Ty (the Show/Hide Properties button) in the

window toolbar.

When you first open the window, in either mode, the oldest maintenance item of the
type is shown at the top of the list and, in Item mode, in the data fields.

Adding New Items To add new items, click on the 'New' icon in the window toolbar. In:
e [tem mode, this clears the fields for new data

e List mode, this displays the '<item type> details for <element type> <element
name>' dialog, which you complete in the same way as the Maintenance
window in Item mode

The fields you complete for each type of maintenance item are almost identical.

Applying Automatic On the Maintenance window in Item mode, or on the 'Item Details' dialog, you can

Naming/Numbering apply an automatic naming/numbering convention that you have previously
defined, to each new item record. To do this, simply click on the Auto button next
to the 'Name' field.
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If you already have some text in the 'Name' field, it is over-written by the
auto-counter text.

Maintenance Item Types The six types of Maintenance Item you can create records for are each managed on
a separate instance of the window:

e Defects - each recording a failure to meet a requirement for the current model
element

e Changes - each recording a change in requirement for the current model
element

e [ssues - each recording a risk factor that might affect the project, associated
with the current model element

e Tasks - each recording work in progress and work outstanding for the current
model element

e Events - each recording the action taken on a requirement of the current model

element
e Decisions - each recording the choice made on a requirement of the model
element
Element Browser You can also use the Element Browser window to select and display specific items

on the Maintenance window; click on the E3 icon in the Maintenance window
toolbar to display the Element Browser, open the Maintenance folder and select the
required item.

In the folder, the 'page’ icon against each item contains a:
e (C for Change items

e D for Defect items

e T for Task items

e | for Issue items, or

e E for Event items

Notes

e  Columns in the item list can be reorganized, added, removed, grouped, filtered and sorted using the options provided
in the List Header facilities
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Create Maintenance Items

When you need to create a new maintenance record for an element, you can do so by selecting the New' option from the
toolbar of the Maintenance window.

Access

Use one of the methods outlined here to display the Maintenance window for the type of maintenance item to create, then

click on 0 (the 'New' icon).

Ribbon

Construct > Change Management > Changes > Show Changes Window
Construct > Change Management > Defects > Show Defects Window
Construct > Change Management > Issues > Show Issues Window
Construct > Change Management > Tasks > Show Tasks Window
Construct > Change Management > Events > Show Events Window

Construct > Change Management > Decisions > Show Decisions Window

Create maintenance items

Option

Name

Auto

Reported by
Requested
Raised by

Date

Status

Resolved by
Implemented by
Completed by

Date Resolved
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Action

Type the name or a short description of the defect, change, task, event, decision or
issue.

As an alternative to typing in the name, click on this button to insert predefined
auto-counter text.

If you already have some text in the 'Name' field, it is over-written by the
auto-counter text.

Click on the drop-down arrow and select the user name of the person who initiated
the maintenance item.

Defaults to today's date as the date on which the maintenance item was raised; if
necessary, change this by clicking on the drop-down arrow and selecting a different
date.

Click on the drop-down arrow and select the appropriate status of the maintenance
item, such as New or Complete.

Click on the drop-down arrow and select the user name of the person who
completed and closed the maintenance item.

Defaults to today's date as the date on which the maintenance item was completed;
click on the checkbox to select today's date or, if necessary, change the field by
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Date clicking on the drop-down arrow and selecting a different date.
Date Completed
Priority Click on the drop-down arrow and select the priority for completing the

maintenance item.

Version Type the version number associated with this defect, change, task, event, decision
or issue.
Description Type a longer description of the maintenance item; you can format the text using

the Notes toolbar at the top of the field.

This text is also reflected in the Notes window, but cannot be edited there.

History Enter any notes or references to previous occurrences of this maintenance item; you
can format the text using the Notes toolbar at the top of the field.

This text is also reflected in the Notes window, but cannot be edited there.

New Click on this button to clear the fields ready to create a new maintenance item.
OK Click on this button to save the record data and close the dialog.
Close Click on this button to close the dialog without saving the record.
Apply Click on this button to save the record without clearing the data fields or closing the
dialog.
Notes

e To edit an item, right-click on it on the Maintenance window and select the 'Modify Selected' option; the 'Ttem
Details' dialog displays with the values for the selected item in the fields, and you can change those values

e To delete an item, right-click on it on the Maintenance window and click on the Delete icon in the window toolbar;
in response to the confirmation prompt, click on the Yes button

e A further possibility for editing and deleting items is to right-click on items in the Element Browser and select menu
options there; to access an item through the Element Browser, click on the Es icon in the Maintenance window
toolbar and click on the required item in the Maintenance folder in the Element Browser window

e To change the element for which to create or edit maintenance items, click on the new element in the Project
Browser
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Move or Copy Maintenance Items

After you define a maintenance item of one type (Defect, Change, Issue, Event, Decision or Task), you might decide that
the item either is better suited to another type or forms a good template for items of other types. If so, you can either
move or copy the item to the other types.

Access

Display the appropriate Maintenance window using one of the methods outlined here.
In the Maintenance window:
e Right-click on a maintenance item > Move to > <item type> or

e Right-click on a maintenance item > Copy to > <item type>

Ribbon Construct > Change Management > Changes > Show Changes Window
Construct > Change Management > Defects > Show Defects Window
Construct > Change Management > Issues > Show Issues Window
Construct > Change Management > Tasks > Show Tasks Window
Construct > Change Management > Events > Show Events Window

Construct > Change Management > Decisions > Show Decisions Window

Move or copy a maintenance item

Step Action

1 Click on the appropriate option - 'Move to' or 'Copy to'.

A list of maintenance item types displays.

2 Click on the item type to which to move or copy the item.

A confirmatory prompt displays.
3 Click on the Yes button to confirm the move or copy.

4 Switch to the appropriate type version of the Maintenance window to ensure that the item has been added,
and make any necessary changes.

5 If you are copying the item to more than one other item type, repeat steps 1 to 4 for the next item type to
copy to.
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Create Elements From Maintenance Item

A maintenance item identifies a defect, change, issue, event, decision or task concerning an element. The maintenance
item could itself be represented by an element if it has wider implications for the project or identifies - for example - an
actor, activity or action that requires further definition.

You can create one or more elements from any maintenance item, using the Maintenance window. The new element is
connected to the maintenance item's parent element by a Dependency connector. The original maintenance item remains
unchanged as a characteristic of its parent element.

Access

Use one of the methods outlined here to display the Maintenance window appropriate to the maintenance item from
which to create a model element.

In the Maintenance window: Right-click on the maintenance item > Create as New Element

Ribbon Construct > Change Management > Changes > Show Changes Window
Construct > Change Management > Defects > Show Defects Window
Construct > Change Management > Issues > Show Issues Window
Construct > Change Management > Tasks > Show Tasks Window
Construct > Change Management > Events > Show Events Window

Construct > Change Management > Decisions > Show Decisions Window

Create an element from a maintenance item

Step Action

1 On the 'New Element' dialog, complete the fields.
In the 'Type' field, select the required element type; you might create:
e  An Issue element for a Defect or Issue maintenance item
e A Change element for a Change item, or
e An Action for a Task item
You can, however, create a wide range of other element types should any of these be more appropriate.

When you click on the Create button, the new element is added to the Project Browser. You can drag and
drop it onto a diagram from there.
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Show Maintenance Items in Diagram

When you have created a maintenance item, it is useful to make the record visible on its parent element. You can do this
by displaying the record within a maintenance compartment on the element as it displays in a diagram. Any element that
is capable of displaying a compartment, and that has maintenance items assigned to it, can show the items in a diagram.

Show maintenance items in a diagram

Step Action

1 Open a diagram containing the element with the attached maintenance items.

2 Double-click on the diagram background to display the diagram 'Properties' dialog.
Click on the 'Elements' tab.

3 In the 'Show Compartments' panel, select the 'Maintenance' checkbox.

4 Click on the OK button to save the setting.

Each maintenance item now appears in the maintenance compartment of the diagram element.

Maintenance Compartment - Example

JPanel
CCBoockClientPanel

~ bookpansl CCBookPanel = new CCBookPanel()
~ Ibl_Prce: JLebel=new JLabel{"Prca}

+ (CCBookClientPanel)
+ GetBook(): CBook

- getUl : void

- joInit : void

+ SetBook(CBook) : void
- setUI) : void

maintenance
Change: (Merfied) Change to GUI
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Changes, Defects and Issues

If your work in managing a project identifies issues, defects or required changes in the model rather than internal to a
single element, you can represent these using Change, Issue or Defect elements as structured comments with which you
can track and manage the problems.

e A Change element corresponds to a change in requirements for the current system

e An Issue element corresponds to a failure to match the requirements for the current system due to newly arisen
organizational or legal factors such as staffing problems, changes in laws or guidelines, or business unit restructuring

e A Defect element corresponds to a failure to match the requirements for the current system due to a flaw in the
model, system or process, such as a missing element or module, or no inclusion of a necessary actor

You can also define any specific work to be done in researching or resolving the problem using Task elements, and
assign resources to these or directly to the Change, Issue or Defect elements internally, in Resource Allocation, or
externally as Actors.

The use of maintenance elements provides a broad scope for managing changes, defects and issues, providing the facility
to fully define the problem and its resolution with linked documents, both internal and external Notes, and composite
structure diagrams including Interaction and Activity diagrams.

You can create Change, Defect and Issue elements in various UML diagrams (especially Maintenance diagrams) and
connect them using Realization, Dependency, Aggregation and other relationships to show what model elements each
problem affects and how each is resolved. Within the element 'Properties' dialog for Changes, Defects and Issues you can
identify the problem as the element name and record relevant management details, such as owner and dates.

A useful tool in managing problems and changes is the Relationship Matrix, in which you might - for example - link staff
(Actors) through Realization connectors to Issues. Each highlighted square in the Matrix indicates the responsibility of a
staff member to work on or correct a named Issue.
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Issues

In your modeling, issues concerning the development of the system or model might arise; more formally, you encounter
a failure to meet defined requirements for the current system. You can represent this failure using an Issue element,
which is a structured comment containing information about the issue and the measures taken to manage it. The element
is rendered as shown.

Issue Element [

You can link Issues to model elements that are responsible for the issue, using Realize connectors. You can also create a
hierarchy of related Issues using Aggregation connectors. Each Issue element has a status band at the left end, which is
color coded to visually represent the value of the 'Status' field in the element properties. The element has an identifying 'l
in the top right corner, which you can hide if you prefer not to show it.

1

You can create Issue elements on most types of diagram, although the Maintenance diagram is specifically designed for
displaying and managing them. You can also create your own issue-management diagram as a Custom diagram. You can
add the Issue (and other) elements to the diagram from the Diagram Toolbox, or directly to a Package in the Project
Browser.

Add an Issue to the model using the Toolbox

Step Action

1 Open the Maintenance or Custom (or other) diagram to define the problem.
2 From the Custom pages or Common page of the Diagram Toolbox, drag the Issue icon onto the diagram.
3 If the "Properties' dialog does not automatically display, double-click on the element. Record the name and

details of the Issue, in the 'Properties' dialog.

Add an Issue to the model using the 'New Element' dialog

Step Action

1 Identify the Package in which to record the Issue, in the Project Browser.

Right-click on this Package and select the 'Insert | New Element' option.

2 Complete the fields on the 'New Element' dialog - in the '"Type' field, click on the drop-down arrow and
select 'Issue'.

3 When you have created the element, double-click on it. Record the name and details of the Issue, in the
'Properties' dialog.

Notes

(c) Sparx Systems 2015 - 2017 Page 130 of 159 Created with Enterprise Architect



User Guide - Project Management 30 June, 2017

e To toggle display of the letter 'I' in the top right corner of the element, select or deselect the 'Show stereotype icon
for requirements' checkbox on the 'Preferences' dialog, 'Objects' page
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Defects

In your modeling, problems in the development of the system or model might arise; more formally, you encounter an
obstacle to meeting defined requirements for the current system, through a defect of the model, system or process. You
can represent this failure using a Defect element, which is a structured comment containing information about the defect
and the measures taken to manage it. The element is rendered as shown.

Defecti b

You can link Defects to model elements that are responsible for the problem, using Realize connectors. You can also
create a hierarchy of related Defects using Aggregation connectors. Each Defect element has a status band at the left end,
which is color coded to visually represent the value of the 'Status' field in the element properties. The element has an
identifying 'D' in the top right corner, which you can hide if you prefer not to show it.

You can create Defect elements on most types of diagram, although the Maintenance diagram is specifically designed for
displaying and managing them. You can also create your own defect-management diagram as a Custom diagram. You
can add the Defect (and other) elements to the diagram from the Diagram Toolbox, or directly to a Package in the Project
Browser.

Add a Defect to the model using the Toolbox

Step Action

1 Open the Maintenance or Custom (or other) diagram to define the problem.
2 From the Custom pages or Common page of the Diagram Toolbox, drag the Defect icon onto the diagram.
3 If the 'Properties' dialog does not automatically display, double-click on the element. Record the name and

details of the Defect, in the 'Properties' dialog.

Add a Defect to the model using the 'New Element' dialog

Step Action

1 Identify the Package in which to record the Defect, in the Project Browser.
Right-click on this Package and select the 'Insert | New Element' option.

2 Complete the fields on the 'New Element' dialog - in the 'Type' field, click on the drop-down arrow and
select 'Defect'.

3 When you have created the element, double-click on it. Record the name and details of the Defect, in the
'Properties' dialog.

Notes
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e To toggle display of the letter 'D' in the top right corner of the element, select or deselect the 'Show stereotype icon
for requirements' checkbox on the 'Preferences' dialog, 'Objects' page
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Changes

In your modeling it might become necessary to change an aspect of the system or model; more formally, you need to
request and manage a change in the defined requirements for the current system. You can represent this change request
using a Change element, which is a structured comment containing information about the change and the measures taken
to manage it. The element is rendered as shown.

Change Element L

You can link Changes to model elements that are impacted by the change, using Realize connectors. You can also create
a hierarchy of related Changes using Aggregation connectors. Each Change element has a status band at the left end,
which is color coded to visually represent the value of the Status field in the element properties. The element has an
identifying C in the top right corner, which you can hide if you prefer not to show it.

You can create Change elements on most types of diagram, although the Maintenance diagram is specifically designed
for displaying and managing them. You can also create your own change-management diagram as a Custom diagram.
You can add the Change (and other) elements to the diagram from the Diagram Toolbox, or directly to a Package in the
Project Browser.

Add a Change to the model using the Toolbox

Step Action

1 Open the Maintenance or Custom (or other) diagram in which to define the problem.
2 From the Custom or Common pages of the Diagram Toolbox, drag the Change icon onto the diagram.
3 If the 'Properties' dialog does not automatically display, double-click on the element. Record the name and

details of the Change, in the 'Properties' dialog.

Add a Change to the model using the 'New Element' dialog

Step Action

1 Identify the Package in which to record the change, in the Project Browser.

Right-click on this Package and select the 'Insert | New Element' option.

2 Complete the fields on the 'New Element' dialog - in the 'Type' field, click on the drop-down arrow and
select 'Change'.

3 When you have created the element, double-click on it. Record the name and details of the Change, in the
'Properties' dialog.

Notes
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e To toggle display of the letter 'C' in the top right corner of the element, select or deselect the 'Show stereotype icon
for requirements' checkbox on the 'Preferences' dialog, 'Objects' page
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Maintenance Diagram

A Maintenance diagram is a type of Custom diagram, an extension to the UML model. It is a change management tool,

used to record:

e Requests for change to the model structure or project process, as Change elements

e Issues that impact the development and progress of the project, as Issue elements, and

e  Groups of tests that can be applied to many elements rather than specific elements, as Test Cases

Each Change, Issue or Test Case element can link to other model elements in the project, to illustrate how they
contribute to or are impacted by the item, and how they must be modified, removed, applied or extended to provide a
solution. This includes identifying areas of work, represented by Task elements, to which resources can be allocated as
either external (Actor) elements or internal properties (resource allocation).

You generate Maintenance diagram elements and connectors from the Maintenance pages of the Toolbox, although you
might also make frequent use of connectors from other Toolbox pages.

Example Diagram

Example Maintenance Diagram

Maintenance Diagram Element Toolbox Icons

Icon
1  Package
E Issue
if_‘l Change
Tl Task
#  Test Case
1 Entity
L] Test
l=] Defect
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Description

A Package is a namespace as well as an element that can be contained in other
Package's namespaces.

Issue elements represent a failure to meet defined requirements for the current
system.

This element represents a change in the defined requirements for the current system
and can be used to request and manage the change process.

A Task element represents a task that must be performed in relation to an element.

A Test Case is a stereotyped Use Case element. You might use it to extend the
facilities of the Testing window, by applying element properties and capabilities to
the tests of a feature represented by another element or - more appropriately - set of
elements.

An Entity is a stereotyped Object that models a store or persistence mechanism that
captures the information or knowledge in a system.

A Test element represents a step in the Basic, Alternate and Exception Paths of a
Scenario created in a Use Case or other element.

The defect element represents an obstacle to meeting defined requirements for the
current system.
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Maintenance Diagram Connector Toolbox Icons

Icon Description

A Rggregate - An Aggregation connector is a type of association that shows that an element
contains or is composed of other elements.
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Very simply, this example diagram depicts a request for a change (C) to a process represented by an Activity element
(Transfer WH Receipts to Active Stock). The change currently involves the Task (T) of reviewing the interface between
two recording systems, one of which could be affected by an Issue (I) concerning an external stocktaking system.

Warehouse Receipt/Stocktake Update

C

s
T

1
afraces
|

Review Interface 1|7

WH Receipt [
Log

Material Code D
Reference
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Update Package Status

Often a complete Package structure moves from one status to another (such as for release) in one operation. To help
facilitate this, Enterprise Architect supports a 'bulk' update of Package and element Status, Phase, and Version, which
also provides the option of defining the scope of the update.

Access

Context Menu

Project Browser | Right-click on Package | Advanced | Update Package Status

Update Status across a Package

Field

New Status
New Phase
New Version
Modified Date

Set Date

Recursively update all
child packages

Include Elements

Include Element
Requirements

Include Element
Constraints

OK
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Action

Type in or select the new status of the Package.
Type the new phase.

Type the new version.

System set; you cannot change this field.

Defaults to selected to apply the Modified Date; if necessary, deselect to ignore the
date stamp on the change.

Select to apply the changes through all child Packages of the selected Package;
deselect to apply the changes to only the selected Package.

Defaults to selected; if the changes are to apply only to Package elements, deselect
the checkbox.

Defaults to selected, to update the element requirements' 'Status' field; deselect to
ignore this field.

Defaults to selected, to update the constraints' 'Status' field; deselect to ignore this
field.

Click on this button to update all required elements to the new status.
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The Project Status View

The Project Status view documents tasks and issues that relate directly to the current project, and lists the statistics of the
project.

Access
Ribbon Construct > Project > Status > Project Status (Tasks and Issues) > [Tab page]
Tabs
Tab Detail

Tasks Review major project tasks that require attention.

Issues Review events, occurrences and situations that impact on project development and
delivery. You can also generate a document report on these issue items.

Project Statistics Review the project statistics, on the "Project Statistics' tab. This simply lists the
numbers of Packages, diagrams, elements, connectors, elements of each type and
element features of each type in the project.

For certain items, such as element risks, metrics and effort, if there are no instances
of that particular object type it is still listed but with a count of 0.
Notes

®  You can add or work on an item in the 'Project Status' view by right-clicking (context menu) or double-clicking on
the blank or completed item line

e The 'Project Status' view context menu has options for filtering tasks and issues by status; you can also rearrange the
sort-order by clicking in the title bar of the column that the items are to be indexed on

(c) Sparx Systems 2015 - 2017 Page 140 of 159 Created with Enterprise Architect



User Guide - Project Management 30 June, 2017

Project Tasks

The 'Tasks' tab of the Project Status view provides a convenient 'To Do' list of major project work items that are not
recorded elsewhere, and can be used to track events such as requests or corrections.

Access

Ribbon Construct > Project > Status > Project Status (Tasks & Issues) > Tasks

Notes

e Right-click on the list to view the context menu, and select to add, modify or delete tasks, or to set a status filter
®  You can re-organize the display of the listed tasks using the List Header facilities for reported information
e To print out the currently displayed items, select the 'Print List' context menu option

e You can transport task definitions between models using the 'Configure > Model > Transfer > Export Reference
Data' and 'Tmport Reference Data' options
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Add, Modify and Delete Tasks

This topic explains how to add, edit and delete project tasks.

Access

Ribbon Construct > Project > Status > Project Status (Tasks & Issues) > Tasks
Start > Today > Calendar > Project Tasks mode

Maintain Tasks

Step Action

1 If creating a new task:
e Double-click in a blank area of the 'Tasks' tab, or on a cell of the Calendar
If editing an existing item:
e Double-click on the item on the 'Tasks' tab or Calendar
The 'Task Detail' dialog displays.

2 Enter or update these details of the task, selecting a value from the field's drop-down list where
appropriate:

e The task name

e Automatic naming - if you have set up automatic naming conventions, click on the Auto button to
insert the predefined element name and counter text; if you already have some text in the Name'
field, it is over-written by the automatic naming text

e The task type

e  The task owner

e The expected start and end date for the task (select the check boxes to activate the dates)
e The current status of the task

e  The person this task has been assigned to

e  The task priority: high, medium or low

e The expected total time for the task and the actual time expended (in complete units; the type of unit
must be agreed across the project)

e The percentage completion

e The phase associated with this task

e A description of the task

e Any progress history appropriate to the task

3 Click on the Apply button.
4 To create another entry click on the New button or, to close, click on the OK button.
5 To delete a task:
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e Right-click on the task and select the 'Delete’ option

e  Click on the Yes button on the confirmation prompt

Notes

e 'Owner' and 'Assigned' fields are filled from the Project Authors, Resources and Project Clients
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Project Issues

Any identified issues can be recorded against the current project, using the 'Issue Detail' dialog from the 'Issues' tab of
the Project Status view. For each Issue, you record the description, date, owner and status.

Access

Ribbon Construct > Project > Status > Project Status (Tasks & Issues) > Issues

Operations

Operation

Add, edit and delete Issues

Generate and view a rich text format report of your issue list

Notes

®  You can transport these issue definitions between models, using the 'Configure > Model > Transfer > Export
Reference Data' and 'Tmport Reference Data' ribbon options

e To print out the currently displayed items, select the 'Print List' context menu option
e You can re-organize the display of the listed tasks using the List Header facilities for reported information

e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have 'Manage Issues' permission to update and delete Issues records
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Add, Delete and Modify Issues

You can maintain project issue records using either the:
e 'Issue Detail' dialog from the 'Issues' tab of the Project Status view, or
e 'Project Issues' dialog

These two dialogs have very similar fields.

Access

Ribbon Construct > Project > Status > Project Status (Tasks & Issues) > Issues

Maintain Project Issues

Step Action

1 If creating a new issue:

e  On the 'Issues' tab of the 'Project Status' view, double-click in a blank area to display the 'Issue Detail'
dialog, click on the New button

or
e On the 'Project Issues' dialog, click on the New button
If editing an existing item:

e  On the 'Issues' tab of the 'Project Status' view, double-click on an item to display the 'Issue Detail'
dialog

or

e On the 'Project Issues' dialog, click on the item within the 'Project Issues & Discussion' list

2 Enter or update these issue details, selecting a value from the field's drop-down list where appropriate:
e The issue name

e Automatic naming - if you have set up automatic naming conventions, click on the Auto button to
insert the predefined element name and counter text; if you already have some text in the Name'
field, it is over-written by the automatic naming text

e The issue priority

e  The date the issue was raised

e  The issue status

e The issue owner

e A description of the issue

e  The name of the person who resolved the issue

e The date on which the issue was resolved (select the check box to activate the date)

e  Any comments on the resolution

3 Click on the Apply button or Save button.

(c) Sparx Systems 2015 - 2017 Page 145 of 159 Created with Enterprise Architect



User Guide - Project Management 30 June, 2017

4 If the issue is closed (and all the 'Resolution' fields are completed), click on the Close Issue button.

5 To create another entry click on the New button or, to close, click on the OK button or (on the 'Project
Issues' dialog) the Close button.

6 To delete an issue:

e  On the 'Issues' tab, right-click on the entry and select the 'Delete' option, then click on the Yes button
on the confirmation prompt

or

e On the 'Project Issues' dialog, click on the item in the 'Project Issues & Discussion' list, ensure that
the 'Resolution’ fields are complete, then click on the Delete button

Notes

e You cannot delete a Closed issue through the 'Project Issues' dialog

e  You can filter the list of issues by status, to include or exclude:
- On the 'Issues' tab, all issues or just Open, Closed or Under Review issues, using the 'Set Term Filter' context
menu option
- On the 'Project Issues' dialog, closed issues, using the 'Show Closed Issues' checkbox
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Report From Project Issues Dialog

This topic explains how to generate a document report on your project issue records, from either the Project Status
window, or from the 'Project Issues' dialog.

Access

Ribbon Construct > Project > Status > Project Status (Tasks & Issues) > select 'Issues' tab >
right-click and choose 'Create Report'

Generate a Project Issues report

Step Action

1 On the Project Status window, click on the 'Issues' tab to show the 'Issues' page.

2 Right-click anywhere on the 'Issues' page and from the context menu, choose 'Create Report'.

The 'Save As' dialog displays.

3 Browse for and select the appropriate file location.

In the 'File name' field, type the file name for the report.

4 Click on the Save button.

A status message displays when the report has been generated.
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Report From Project Issues Tab

This topic explains how to generate a document report on your project issue records using the 'Issues' tab of the Project
Status view.

Access

Ribbon Construct > Project > Status > Project Status (Tasks & Issues) > Issues >
Right-click on Issues list > Create Report

Generate your project issues report

Step Action

1 Right-click on the Tssues' tab and select the 'Create Report' option.
The 'Save As' dialog displays.

2 Browse for and select the appropriate file location.

In the 'File name' field, type the file name for the report.

3 Click on the Save button.

A status message displays when the report has been generated.

4 Click on the OK button and then on the View RTF button.

The report displays in your default viewer.

Use to

e  Generate and view a document report on project issues
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Report Output Sample

This is an example of the output from an Issues report.

List of Project Issues: 24-Jul-2010 9:47:00 AM

Issue Date/Owner Description Resolution
Test servers will be delayed |24/07/2014 Eloise Norman | The test server builds have been delaved  |Closed: 24/07/2014 Geoffrey
because the particular (unusual) memorv | Sparks
requirements to match the customer's site
are not available on shore. They are being | The machines will be built and
sourced from Singapore but it will delay the delivered using standard memory
builds and delivery of the machines. and the proprietary memory will
be added later. All performance
tests will be delaved until the
memory is available.
Public Holidavs 24/07/2014 Joanna Stoat The schedule includes staff working on Open: 24/07/2014
public holidays. A number of staff have
indicated that contrary to what they stated
earlier they are not available.
Compiler Version disparity  |24/07/2014 Eloise Norman | A number of the developers have Under Review: 24/07/2014
downloaded different versions of a number
of the compilers. This has lead to
unpredictable builds impacting on testing.
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Use Case Estimation

Project estimation is the task of working out how much time and effort is required to build and deploy a solution.

The Use Case metrics facility in Enterprise Architect provides a starting point for estimating project effort; using this
facility you can get a rough measure of the complexity of a system and some indication of the effort required to
implement the model. Like all estimation techniques, Use Case metrics requires some experience with previous projects
to 'calibrate' the process.

There is additional information available on Use Case metrics on the Sparx Systems website.

Access
Ribbon Configure > Reference Data > Project Types > Estimation Factors
Processes
Process Description
Calibrating These values must be carefully calibrated in order to gain the best possible
estimates:
e  Technical Complexity Factors, which are values that attempt to quantify the
difficulty and complexity of the work in hand
e Environment Complexity Factors, which are values that attempt to quantify
non-technical complexities such as team experience and knowledge
e  Default Hour Rate, which sets the number of hours per Use Case point
Estimating Once you have entered all the calibration values, you can estimate the project

timescale through the 'Use Case Metrics' tab of the QA ReportsView.

The estimation process also draws on information on Use Cases recorded on the
'Resource Allocation' tab.
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Technical Complexity Factors

Technical Complexity Factors (TCFs) are used in the Use Case Metrics estimation technique.

The EABase.cap model contains a default set of TCFs, which you can add to or modify using the 'Estimation Factors'
dialog. This set of factors should include all factors that could affect the technical complexity of the project environment.

Access

Ribbon Configure > Reference Data > Project Types > Estimation Factors > Technical
Complexity Factors

Maintain Technical Complexity Factors

Step Action

1 On the '"Technical Complexity Factors' tab, either:
®  (Click on the New button to add another TCF, or
e  Click on the required factor in the 'Defined Technical Types' list to edit it (go to step 3)

2 In the 'Factor Number' field, type the appropriate TCF number.
3 In the 'Description' field, type or edit the TCF description.
4 In the "Weight' field, type or edit the technical complexity weighting.

This indicates how much technical complexity you assign to a factor; for example, 'the system is to be
developed in ADA' might warrant a higher weight than 'the system is to be a shell script'.

5 In the 'Value' field, type or edit a value representing the degree of influence the factor has on the project.
As a suggested gauge:
e 0 indicates no influence
e 3 indicates average influence

e 5indicates strong influence

6 Click on the Save button.
7 Examine the 'Defined Technical Types' list, and scroll across it to show the 'Ex Value' column (Weight x
Value).

The summed Ex Values yield the 'Unadjusted TCF value' (at the bottom of the dialog).

The 'Unadjusted TCF value' is combined with the Environment Complexity Factors to skew the overall
complexity up or down, depending on the level of technical complexity and the corresponding level of
environmental support.
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Notes

e The TCF Weight evaluates its respective factor, but is irrelevant to a project; the 'Value' field assesses each factor's
role within a project and, for most purposes, is the only field requiring adjustment

e The supplied factors and their associated weights are defined by the Use Case Points Method, although they can be
adjusted to suit a project's specific requirements

®  You can transport the Technical Complexity Factors between models, using the 'Configure > Model > Transfer >
Export Reference Data' and 'Tmport Reference Data' ribbon options
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Environment Complexity Factors

Environment Complexity Factors (ECFs) are used in the Use Case Metrics estimation technique.

The EABase.cap model contains a default set of ECFs, which you can add to or modify using the 'Estimation Factors'
dialog. This set of factors should include all factors that could affect the general design and development environment,
including team experience and knowledge, team size, expertise and other non-functional environmental factors.

Access

Ribbon Configure > Reference Data > Project Types > Estimation Factors > Environment
Complexity Factors

Maintain Environment Complexity Factors

Step Action

1 On the 'Environment Complexity Factors' tab, either:
e  (Click on the New button to add another ECF, or
e  Click on the required factor in the 'Defined Environment Types' list to edit it (go to step 3)

2 In the 'Factor Number' field, type the appropriate ECF number.
3 In the 'Description' field, type or edit the ECF description.
4 In the "Weight' field, type or edit the environment complexity weighting.

This indicates how much complexity you assign to a factor.

5 In the 'Value' field, type or edit a value representing the degree of influence the factor has on the project.
As a suggested gauge:
e 0 indicates no influence
e 3 indicates average influence

e 5indicates strong influence

6 Click on the Save button.
7 Examine the 'Defined Environment Types' list, and scroll across it to show the 'Ex Value' column (Weight
x Value).

The summed Ex Values yield the 'Unadjusted ECF' value (at the bottom of the dialog).

The Unadjusted ECF value is combined with the Technical Complexity Factors to skew the overall
complexity up or down, depending on the level of technical complexity and the corresponding level of
environmental support.
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Notes

e The ECF Weight evaluates its respective factor, but is irrelevant to a project; the 'Value' field assesses each factor's
role within a project and, for most purposes, is the only field requiring adjustment

e The supplied factors and their associated weights are defined by the Use Case Points Method, although they can be
adjusted to suit a project's specific requirements

®  You can transport the Environment Complexity Factors between models, using the 'Configure > Model > Transfer >
Export Reference Data' and 'Tmport Reference Data' ribbon options
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Default Hours

Setting an hourly rate is the most difficult factor in an accurate estimation. Typical ranges can vary from 10 to 30 hours
per Use Case point.

Studying the Use Case Points Method, from which this variable is defined, can help you to understand its role in the
estimation and facilitate selection of a suitable initial value.

The best way to estimate this value is through analysis of previous completed projects. By calculating the project
estimation on a completed project for which the Use Cases and environment are configured within Enterprise Architect,
you can adjust the hour rate to render an appropriate value for your unique work environment.

Access

Ribbon Configure > Reference Data > Project Types > Estimation Factors > Default Hour
Rate

Set the default hour rate per adjusted Use Case point

Step Action

1 In the 'Duration’ field, type the number of hours per Use Case Point.
2 In the 'Hourly Rate' field, type the cost per hour.
3 Click on the Close button.

Notes

e  The values you enter are stored as local settings on your computer only

e This option is also active in the 'Lite', read-only version of Enterprise Architect
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Estimating Project Size

Enterprise Architect uses a simple estimation technique based on the established:
e Number of Use Cases to be built

e Difficulty level of those Use Cases

e  Project environment factors and

e  Build parameters

This technique is of value only once you have developed a couple of known projects to use as a baseline. Please DO
NOT use the provided 'guesstimates' as a real world measure until you have some real world base lines to measure
against.

Access Select Package in Project Browser:
Construct > Project > Status > QA Reports and Use Case Metrics > Use Case Metrics, or

Right-click | Documentation | Package Metrics > Use Case Metrics
Complete a Use Case Metrics Estimation

Field Action

Root Package Confirm the root Package in the hierarchy.
All Use Cases under this Package could potentially be included in the report.

Reload Re-run the load from the selected Package, usually after you change the filter
criteria.
Phase like Include Use Cases with a phase that matches the wildcard value in the field.

Use * to match any characters, for example 1.* for 1.1 and 1.2.

Keyword like Include Use Cases with a keyword that matches the wildcard value in the field.

Use * to match any characters.
Bookmarked Include all Use Cases, or only those that are tagged, or those that are not tagged.

Use Cases Check the total count of Use Cases in the estimate.

The Use Cases and their parameters are listed in the panel underneath this field.

Include Actors Select to include Actors in the estimate.
Technical Complexity Review the parameters that describe the degree of technical complexity of the
Factor project.

While the 'Unadjusted TCF Value' comes from the 'Technical Complexity Factors'
tab of the 'Estimation Factors' dialog, the other values compose the Use Case Points
Method formula.

Modify these fields with caution.
The final project estimate is directly proportional to the TCF.

Environment Complexity Review the parameters that calculate the degree of environmental complexity of the
Factor project, from factors such as programmer motivation or experience.
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The listed parameters compose the formula calculating the ECF, defined by the Use
Case Points Method; the only parameter affected by the project is the Unadjusted
ECF Value, derived from the 'Environment Complexity Factors' tab of the
'Estimation Factors' dialog.

The final project estimate is directly proportional to the ECF.

Unadjusted Use Case Check the sum of the Use Case complexity numbers.

Points (UUCP)

Ave Hours per Use Case Check the average number of hours assigned to easy, medium and difficult Use
Cases.

You cannot change these figures.

Total Estimate Review the detailed breakdown of the final figure.

You must tailor the hours per Use Case Point figure to the level that matches your
type of project and capability based on known previous project outcomes.

Default Rate Set the Default Hours to be fed into the final calculation.

Re-Calculate Re-run the estimate, usually after you change the hours or Use Case point number.
Report Produce a rich text formatted report from the current estimate.

View Report Display the last-generated report.
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Monitor Change Events

You can automatically monitor work events in your project, using the Model Views facility.

Guide
Aspect Detail
Model Views This facility enables you to:
e Automatically refresh a search in a View at an interval that you define
e Notify you if the results of the search change between two consecutive
searches
You can therefore use Model Views to monitor various events in the development
project, depending on how you set up the search in a View.
Example You could set up a search to detect:
e Change items, or Issue items, so that Enterprise Architect would notify you as
new items were created
e Element Status, Type, Phase, Version, Priority and/or date of last update, so
that Enterprise Architect would notify you as items were progressed to:
e Fall in to the level of work represented by the search categories or
e Move out of the categories into the next level of work
e Tagged Values, so that - again - as items were changed to satisfy the criteria of
a sequence of searches, the progression of items through a set of stages could
be checked and managed
Personalization People responsible for different stages in a process could have their own Model
View searches so that:
e As adevelopment, validation or authorization task falls due the responsible
person is automatically notified, and
e When the work is complete both the next person in line and the overseeing
manager are notified
Notes

e  This facility is available in the Enterprise Architect Corporate, Business and Software Engineering, Systems
Engineering and Ultimate editions
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